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This Manual

The Production Manual is intended to empower 
your creative process, serving as an initial guide 
and continuing reference for a variety of analog and 
digital working methods. 

This resource covers introductory conceptual 
skills and technical knowledge including common 
representational conventions, best working 
practices, and foundational strategies to convey 
your design ideas while developing good working 
habits and time management skills. 

Throughout the Production Manual, additional 
resources including suggested readings and QR 
codes linking to relevant videos and information 
from LinkedIn Learning, YouTube, and other 
sources supplement introductory instructions. 

Like the continued development of this text, your 
design process and working methods will continue 
to evolve as you gain expertise and learn to employ 
your skills in an intentional way. 
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Architectural Drawing

Why Draw?
Architectural drawing, whether analog or digital, 
is a fundamental skill in architectural design. It is 
both a process of observation and act of description.  
This kind of drawing, also referred to as drafting, 
is distinct from the sketch, which may be quickly 
rendered and may be less precise or variable in 
terms of how questions of scale and proportion are 
treated.  

Regardless of the tools and processes used, 
architectural drawing allows architects to develop 
and think through their own ideas, to communicate 
designs to clients and collaborators, and to describe 
how buildings are to be physically constructed. 

Understanding and consistently following 
foundational drafting conventions will assist you in 
clearly conveying your design ideas to others.

The following paragraphs discuss a selection of key 
terms and techniques in greater detail.  Examples 
of student work are included alongside the text for 
reference. 

a method for drawing of a three-dimensional object 
accurately on a two-dimensional surface, a parallel 
projection in which all the projection lines are orthogonal 
to the projection plane and all dimensions are accurately 
represented to a scale without foreshortening, typically 
referring to primary drawing views of plan, section, and 
elevation

a drawing looking down on an object from above, can be a 
top view or a cut plan with a horizontal cutting plane

a drawing of a vertical cut through an object viewed 
horizontally

a drawing of the exterior of an object viewed from the 
side

a drawing that shows a 3D view of an object in which the 
x, y, and z axis are all drawn to scale

a representation of the surface or ground on which the 
object is placed or in which a building is embedded

also referred to as "stroke", describes both the thickness 
and darkness of a line, ‘heavier’ lineweights are thicker/
darker and convey information closer to the cutting 
plane, while ‘lighter’ lineweights are thinner/lighter and 
convey information further from the cutting plane

also referred to as guidelines or regulating lines that 
extend across a page used as reference points for position 
and dimension between multiple elements or drawings

the style of line in a drawing (continuous, dashed, etc.), 
different line types represent different information

the supposed plane that cuts through an object to create a 
section or plan cut

the way elements in a drawing are organized and 
arranged on a page together or the way a series of 
drawings are organized and arranged together

Key Terms

orthographic projection

plan

section

elevation

axonometric projection

ground plane

lineweight

construction lines

line type

cut plane

composition
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Orthographic Projection
Orthographic drawing, while highly precise and 
information-rich, is also an abstraction. The 
horizontal and vertical planar ‘cuts’ that produce 
plans and sections rely on specific conventions to 
communicate conditions of solid, void, mass, and 
implied spatial depth. These conventions produce a 
graphic hierarchy, rendering spaces legible, despite 
the spatial compression and material occlusion 
produced by the orthographic projection. 

Orthographic projection provides a way to 
accurately draw three-dimensional objects through 
two-dimensional representation. An orthographic 
projection accurately maintains the dimensions and 
proportions of an object, meaning the drawing can 
be measured accurately to the dimensions of the 
object. 

There is no foreshortening or perspective in an 
orthographic drawing. The most common types 
of orthographic projection used in architectural 
representation are plan, section, and elevation.

Plan describes a horizontal picture plane of an 
object or space, looking down from above. Plans 
can be simple top views, usually referred to as roof 
plans, or can be cut through an object in the same 
manner as a section while maintaining a horizontal 
view. Sections and elevations describe a vertical 
picture plane, viewing an object from the side. 
Elevations are side views of the exterior of an object 
or building, often from the front, back, left and 
right, or north, south, east and west elevations. A 
section is a cut through an object, showing interior 
spaces. When drawing a section, imagine a vertical 
plane cutting an object in two, then viewing into 
the object beyond the cutting plane (like slicing 
a pepper in half with a kitchen knife and looking 
inside).

The inherent abstraction of architectural drawing 
requires an equally necessary attention to specific 
conventions and notations that, while seemingly 
aesthetic or esoteric to the casual or untrained 
eye, are key to graphically communicating spatial 
hierarchy, functionality, solid/void conditions, or 
even materials and assemblies in plan, section, and 
elevation.

Controlling the "weight" or thickness of a line is 
the most common, and perhaps most important, 
method for establishing graphic hierarchy in a 
drawing.

Lineweight
Line or “stroke” weight refers to the thickness of 
a line in millimeters. For the purposes of hand 
drawing, mechanical pencils and drafting pens are 
available in a range of thicknesses. 

Empty coffee cup in 
perspective

Plan (roof plan) Plan (cut plan)

Elevation Section
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intersect with the cutting plane in a section or cut 
plan. Sections lines can also be understood as the 
edge between solid material and void/space). This 
means that two section lines are needed to describe 
opposite faces of a wall, with the distance between 
them representing the thickness of the wall.

A specific kind of section line can be used to de-
scribe the ground plane. The ground plane is the 
line cutting through the ground on which an object 
rests or in which a building is embedded. This line 
represents the edge between solid earth below and 
open space and air above, and is sometimes slightly 
heavier than a typical section line to give the ground 
some extra visual weight.

When drawing a section through an object or as-
sembly with multiple parts, such as a wall, multi-
ple pieces of material are cut through. In certain 
drawings, such as technical construction drawings, 
it is important to draw all of the edges of each part 
of an assembly to understand how it is built. When 
describing architectural space, this information is 
usually unnecessary. Instead, a single section line 
can be used to describe the outermost edges of all 
the objects, as if they were glued together or made 
of a single material, including where a building 
connects to the ground. This means that the section
line will clearly describe the edge between solid 
matter and inhabitable space. 

Lineweights

Left: Sectional cut through 
coffee cup with ground 
plane; Right: Sectional cut 
through coffee cup with 
ground plan and poche

The same convention has been adopted for CAD 
programs, which always included various methods 
for controlling the line thicknesses when printing, 
plotting, or rasterizing drawing output.

Specifying line weights within a drawing is a matter 
of calibration and there is no universal convention 
for doing so. However, many professional offices 
will designate internal graphic standards for their 
finished drawings, which include specifications 
for line weight, type, and color. Over time you 
will formulate your own set of graphic standards 
through experimentation, iteration, and feedback.

By convention the heaviest line weight in a 
drawing should be reserved for elements being 
cut in plan and section, including the line of the 
ground plane. Elements shown in profile, or of 
lesser importance will utilize a lighter line weight. 
You can include as many or as few distinct line 
weights as necessary in a drawing, but in general, 
designating a thin, medium, and heavy line weight 
within a single drawing will produce a clearly 
legible graphic hierarchy to help communicate the 
relative importance, properties, or spatial depth of 
orthographic elements in plan, section, or elevation.

Drawings usually consist of multiple different 
lineweights, and allow description of depth 
within a 2D drawing. There are several lineweight 
conventions that allow drawings to be easily 
understood. Generally, lineweights can be described 
in a few categories listed below. As a guiding 
principle, decisions about lineweight always 
ultimately come down to making drawings that are 
as clearly legible as possible.

Section Lines
Section lines (also called ‘section cut lines’ or 
simply ‘cut lines’) are the heaviest lineweights in 
a drawing. They describe the edges of objects that 
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Sometimes you will see drawings in which the solid 
parts of a section cut are hatched with a pattern 
or solid color. This technique is called ‘poche,’ and 
is largely a stylistic choice — it is not necessary 
to describe a section cut. Very dark or black poche 
that obscures the legibility of adjacent lineweights 
should be avoided.

Elevation Lines
Beyond the section cut, a range of elevational lines 
describe the edges of physical objects in the distance 
(horizontally in a section or below in a plan). 
Elevation lines are typically drawn in a hierarchy 
of lineweights calibrated to distance: closer objects 
are a heavier lineweight while more distant ones 
are lighter lineweight. This means that as elements 
become farther away, the lineweight decreases, but 
lines should always be drawn in a single lineweight, 
and not taper or fade along the length of a single 
line. All elevation lines should always be lighter 
than section lines so there is never any confusion 
about what is being cut through and what is being 
viewed in the distance.

Elevation lines can be further fine tuned by drawing 
finer details in lighter lineweights than larger 
volumes or surfaces. In elevation drawings, the 
ground plane is usually drawn as a section line, 
with a range of elevation lines describing all other 
parts of the drawing in the distance.

Construction Lines
Construction lines (also sometimes referred to as 
‘guidelines’ or ‘regulating lines’) are the thinnest 
and lightest lines in a drawing. They do not 
represent physical objects, but instead project the 
edges of elements across a drawing. Construction 
lines are not limited to straight lines, but can be 
circular or curved in order to project non-linear 
edges into space. They are useful both for literally 

constructing a drawing, and for reading and 
understanding various alignments and dimensions 
in a drawing.

Construction lines typically extend all the way 
across a drawing page, connecting multiple parts 
of a drawing or multiple different drawings to each 
other. These lines can be used as reference points 
for translating position and dimension between a 
plan and a section. Construction lines should be 
heavy enough that they are visible, but light enough 
that they are barely seen when viewing a drawing 
from a greater distance.

Testing Lineweights
When working on a drawing either by hand or on 
the computer, it is important to check that your 
range of lineweights is clearly legible in the way 
you intend. To test this, pin your drawing on the 
wall (with a test print if drawing digitally) and step 
back a few feet. Your drawing should be clearly 
legible from this distance. If you squint your eyes 
while looking at your drawing, the construction 
lines should disappear fist, followed by the elevation 
lines, until only the section lines are visible before 
you close your eyes. This quick test can help ensure 
that you have a clear hierarchy of lineweights.

Line Types
Line type describes the continuity of a line. 
Most lines are continuous lines, but dashed or 
dotted lines can also be used to describe different 
conditions. Like lineweights, there are certain 
conventions for line types that aid in legibility. 
Continuous or solid lines are used to show objects 
that are visible in a drawing. Dashed lines (or 
hidden lines) are used to show objects that exist 
behind or above the cutting plane. These are most 
commonly used to describe the edges of balconies, 
beams, or other protrusions occurring overhead if 
you were standing in a particular location in plan. 

Construction lines are 
pulled from plan and 
section cut line in plan 
to draw dimensions in 
section.

Line Types
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Dashed lines should only be used to draw critical 
elements — drawing all elements behind the 
cutting plane will reduce the clarity of the drawing. 
There are many other line types, but these typically 
symbolize specifics in construction drawings.

Constructing Multiple Orthographic Drawings
Once a plan, section, or elevation is drawn, 
construction lines can be used to facilitate 
other drawings without duplicating work and 
measurements. To do this, construction lines are 
used to translate dimensions and locations between 
points in different drawings. Construction lines 
will commonly be used to construct a vertical and 
horizontal grid that project edges of elements 
across the page. Construction lines are not limited 
to orthogonal orientations, and can also be drawn at 
different angles and are sometimes curved.

Most commonly, this will entail using a plan to 
construct a section, with a process as follows:
1.	 Start by drawing a construction line across the 

plan to represent where the cut is taking place. 
This marks your cutting plane.

2.	 Identify where you would like to draw your 
section, and draw a line parallel to the cutting 
plane. This will represent an abstracted flat 
ground plane.

3.	 Identify locations where lines in the plan 
intersect the cutting plane. At each of 
these locations, draw a construction line 
perpendicular to the cutting plane that extends 
across your section. This establishes horizontal 
relationships with the elements being cut 
through.

4.	 Offset the ground plane upward with a series of 
parallel lines. The distances between these lines 
should be measured to represent the vertical 
heights of elements in the section.

5.	 Once you have enough vertical and horizontal 
locations, begin delineating elements with sec-
tion cut lineweights.

6.	 After the cut lines are established, use addition-
al construction lines as needed to locate edges 
for elevation lines beyond the section cut.

7.	 Don’t forget to draw your ground plane as an 
extension of the section cut lines.

It is important that sets of construction lines are 
drawn parallel to one another to maintain dimen-
sional accuracy. If they are at an angle on the page, 
simply make sure that they are all drawn at the 
same angle when constructing a particular drawing. 
The angle pulled from one drawing to another is 
not arbitrary and must describe the orientation of 
a cutting plane or view being translated into a new 
orthographic projection. You can get creative with 
curving or concentric construction lines, as long as 
the distance between them does not change.

Composition
Since drawings are often constructed in relation to 
each other, their composition on a page should be 
considered. Following are some concepts to consid-
er when laying out a drawing composition:
-	 A focal point (or points), are the primary sub-

jects within a drawing. The viewer’s eye is often 
drawn to and lingers on the focal point.

-	 Negative space, or the blank space on a page, 
can be very helpful to frame various elements 
or subjects. By leaving negative space on the 
page, more emphasis is brought to the subject 
and allows elements room to breathe.

-	 Contrast is the measure of difference between 
objects in a composition and can be shown 
through different lineweights, densities, scale, 
tone, and negative space.

Youtube: Quick Axonomet-
ric Tutorial
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-	 Rhythm in a competition is a repetition of 
forms or drawings, such as a set of serial 
sections cut sequentially along the length of 
an object. Pattern and rhythm can emerge to 
create dynamic visual interest. Consider the 
spacing, density, and overlap to create rhythm 
and a sense of movement.

-	 Balance within a composition is constructed 
through a thoughtful choreography of these 
various compositional ideas.

-	 Finally, consider the clarity and legibility of 
your composition, and what it needs to convey 
to the viewer. Sometimes a single plan, sec-
tion, or element needs to be closely read, and 
sometimes the relationships between parts or 
drawings are more important to convey ideas.

Axonometric Projection
Axonometry refers to a range of pictorial 
drawing conventions in which all parallel lines 
are represented as parallel.  Like plan, section, 

Repetition and overlap 
create a sense of motion. 
Sections are aligned above 
elevations. Drawing by 
Elaine Cui, UVA SoA 
ARCH 1030.

Constructing a plan 
oblique axonometric from 
a plan drawing.

and elevation, axonometric drawings are parallel 
projections that are dimensionally accurate without 
perspectival distortion.  Axonometrics depict 3D 
views of an object in which the x, y, and z axis are 
all visible and drawn to scale. There are several 
types of axonometric projection, with the most 
common being the plan oblique axon (isometric is 
also commonly seen in digital modeling software). 
To construct a plan oblique axonometric:

1.	 Start with a plan drawing.
2.	 Rotate the plan to the desired angle (30, 45, and 

60 degrees are most common, but any angle is 
possible).

3.	 Draw vertical lines up from the plan to 
construct the heights of various edges and 
surfaces. The length of each vertical line should 
be measured accurately to describe the height 
of the object it delineates.

4.	 Connect lines at the top where there are 
continuous edges in the object. If the top 
of a wall is horizontal, the top edge will be 
parallel to the bottom edge. If the top of a 
wall is inclined, the angle does not need to 
be measured and can be drawn by simply 
connecting the tops of the two measured 
vertical edges.

5.	 As you construct the axon with construction 
lines, begin to use elevation lineweights to 
describe the visible surfaces, since many edges 
will be located behind others in the view. In the 
above example, edges that cannot be seen in the 
view are removed entirely.

6.	 There are different approaches to lineweight 
in axons. One strategy is to scale lineweight 
with distance, as typical with elevation lines. 
The other is to scale lineweight with the depth 
of space the line describes: If there is a large 
change in depth from one side of the line to the 
other, the lineweight should be heavier. This 
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	 usually results in heavier lines around the 
top and side profiles of an object, heightening 
a sense of depth in the drawing. Ultimately, 
clarity and legibility of a drawing should drive 
decisions about lineweight.

Remember that in an axon, vertical edges of objects 
are always vertical lines on the page. Edges of an 
object that are parallel in space are always also par-
allel on the page, regardless of their orientation.

Practice sketching axonometric projections, as this 
is a fantastic way to quickly draw and think through 
form and space in 3D.

Common Axonometric Projections and Axes

Isometric

45 degree 
Axonometric 

(Plan-Oblique)

Cavalier
(Elevation-Oblique)

30/60 degree
Axonometric

(Plan-Oblique)

Cabinet
(Elevation-Oblique)

90 degree
Axonometric

(Plan/Elevation-Oblique)
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Analog Drafting

Why Analog Draft?
Analog or hand drafting is essential to learning the 
key components of architectural drawing. Before 
computer-aided design software was introduced, 
all drafting was done by analog techniques. These 
techniques are important to understand how a 
drawing is set up and produced.

Tools
Drafting Board
Provides a smooth surface to mount drawing paper. 
If unavailable, a clean and smooth table or desk will 
suffice, as long as it has at least one or two straight 
edges. Any raised marks or bumps in the surface 
will impact linework in your drawing.

Drafting Tape
To mount your drawing paper. Sometimes found as 
drafting dots. In a pinch, other light tapes will work, 
but use caution to make sure your paper is not 
ripped upon removal.

Pencils
There are a few options for drafting pencils: tradi-
tional wood pencils; lead holders, which use 2mm 

lead; and mechanical drafting pencils, found in 
0.3,0.5, 0.7, and 0.9mm lead sizes. A variety of lead 
hardnesses will help to achieve a range of line-
weights. Typical lead hardness scale:
softest -> 4B, 2B, B, HB, H, 2H, 4H <- hardest

Pencil Sharpener
Used in the case of wood pencils, or a lead pointer 
in the case of lead holders. If using a non-mechan-
ical pencil, you will need to sharpen frequently to 
maintain crisp and consistent lineweights.

Eraser
Any common pink, white, or black eraser should 
work. Kneaded erasers can be used to help clean up 
smudging.

T-square
Available in a variety of sizes and materials. Some-
times these include measurement marks, but this 
is unnecessary. Make sure the edges are smooth, as 
you will be drawing against these surfaces.

Triangles
Used to create precise angled lines. Commonly 
available in 45-45-90 and 30-60-90, used to draw 45 
degree and 30 or 60 degree lines, respectively. Ad-
justable triangles let you set a specific angle — they 
are typically expensive but extremely useful.

Architect’s scale
An architect’s scale is used to measure and draw 
accurately to scale. It typically looks like a triangu-
lar shaped ruler with several different measuring 
scales on each side. Make sure to use an architect’s 
scale — engineer’s scales look very similar but have 
entirely different measurement scales.

Compass
For drawing circles and arcs. If you plan on doing a 
lot of drawing, a nicer metal compass will be most 
reliable. 

Architect’s Scale

T-square

Drafting Triangles
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Analog drafting workspace 
and supplies.

Pencil

Triangle

Adjustable Triangle T-Square Drawing Paper Architect’s Scale

Drafting Tape

Drafting Board
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Drawing paper
Bristol and strathmore are common opaque papers, 
vellum and mylar are translucent papers. Usually 
a smoother paper is better. Beware of cold press 
paper, which usually has a lot of texture for other 
artistic media.

Drafting Preparation
You will need a clean, flat workspace to draft on. If a 
drafting board is unavailable, make sure your table 
or desk surface is clean and smooth, and that there 
are one or two straight edges upon which to slide 
your T-square.

Before you start a drawing, it is important to spend 
time planning out what you are going to do. This in-
cludes planning your sheet layout and size, includ-
ing any margins. It helps to do some initial sketch-
ing in a sketchbook to have an idea of how you will 
construct your drawing composition.

Once you have a clean workspace and plan for your 
drawing, you will need to tape down your paper. 
First, align your paper with the drafting board 
using a T-square pressed firmly against the side of 
the board. The edge of your paper should be parallel 
to your drafting board. Apply drafting tape or dots 
to each corner to prevent the paper from moving 
as you draw. Now you are ready to begin drawing, 
first with a series of construction lines to locate the 
primary elements in your drawing.

Drafting Techniques
When drafting, it is important to draw all lines 
with the pencil against the edge of a tool (usually a 
T-square or triangle). Highly irregular non-linear 
lines sometimes require freehand drawing, but care 
should be taken to keep a controlled and consistent 
lineweight.

To draw a line, hold your drawing tool firmly 
against the paper so it does not slip, and drag your 
pencil along its edge. Apply even and consistent 
pressure to control your lineweight, and try to draw 
the line in a single stroke. The heavier you want to 
make a lineweight, the more pressure should be 
applied to the pencil when drawing. For a light-
er lineweight, apply lighter pressure. Try not to 
change the angle of your pencil, as this can push 
your line in and out from your straightedge. A slight 
twisting motion of the pencil while drawing can 
help to maintain a consistent lineweight.

Horizontal and vertical lines can be drawn directly 
against a T-square against the edge of the drafting 
board. The ‘T’ top of the T-square is always placed 
on the edge of the drafting board to prevent angu-
lar movement and gives you the ability to slide it 
up and down or across the drawing. Angled lines 
should be drawn against a triangle that is resting 
against the T-square. It is very important to hold all 
drafting tools firmly against each other while draw-
ing so they do not shift.

Left: Use T-square for 
accurate vertical and 
horizontal lines; Right: Use 
triangle with a T-square for 
accurate angled lines.
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Lineweights
Lineweights are key in creating legible drawings 
that clearly describe three-dimensional space. 
When drafting with a pencil, having a few different 
grades of lead is needed to create a range of line-
weights. Remember that H grades are harder leads 
while B grades are softer. Higher numbers denote 
more extreme hardness or softness. Harder leads 
make lighter lines. Softer leads make darker lines, 
but need to be sharpened more frequently and are 
more likely to smudge as you continue drawing. 

Typically, 4H or 2H leads are used for construction 
lines. Elevation lines are usually drawn with H, HB, 
or B leads, depending on preference and how much 
pressure is applied. HB lead is roughly equivalent to 
a standard #2 pencil. Section lines are best drawn 
with a softer B or 2B lead. They will smudge easily, 
so take care not to rub hands or tools over the lines, 
and make sure your sharpen your pencil frequently 
to keep lineweights consistent.

Scale
We use different architectural scales to be able to 
accurately represent large objects through drawings 
that are proportional and measurable at a much 
smaller size. If you are drafting in a 1:1 scale, this 
means your drawings will be to the actual dimen-
sions of whatever you are representing. There are 
many scales used in the architecture and engineer-
ing fields. Architectural scales in the United States 
use imperial units. Common imperial architectural 
scales, from smallest to largest, include:
	 1⁄16” = 1-’0”
	 1⁄8” = 1’-0”
	 1⁄4” = 1’-0”
	 1⁄2” = 1’-0”
	 1” = 1’-0”
	 3” = 1’-0”

Using an architect’s scale 
to measure and draw at a 
scale of 1/4”=1’-0”.

Starting from 0 and following 
ascending numbers, each line 
represents 1’.

These smaller 
divisions represent 
inches.

Feet

Inches

5’

This line represents 5’-6”.

6”

Drawing at a scale of 1⁄4” = 1-’0” means that every 
1/4” in the drawing represents 1’ in real life. It 
would follow that 1”, or 4/4” in the drawing rep-
resents 4’ in real life, etc.

Using a Scale
Your architect’s scale is a wonderful tool to quickly 
draw and measure to scale without having to do 
any math or convert numbers in your head. Archi-
tect’s scales have several standard scales located 
on different edges, often with one scale read left to 
right and another read right to left. When using a 
scale, you will start measuring at zero and follow 
the ascending numbers to measure feet. Before the 
zero on the scale, there are a series of smaller lines 
— each of these lines represents one inch.
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Cleanliness
Keeping drawings clean takes care and patience. 
Make sure your workstation and hands are clean 
before touching your paper. If you get graphite on 
your hands or drawing tools, make sure to wash 
immediately to prevent smudging. Drawing lines 
first as construction lines will help you to make sure 
that you are committing to heavier lineweights once 
you are sure of a line’s location. This will mean you 
can minimize erasing in your drafting process.

Drawing by Kevin Holcombe, 
UVA SoA ARCH 1030

Section lines
B or 2B lead

Construction lines
2H or 4H lead

Elevation lines
H, HB or B lead

Hidden lines
H lead
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Computer Aided Drafting

Why Computer Aided Drafting?
Computer aided drafting (CAD) has been the 
predominant medium for the production of 
architectural drawings since at least the beginning 
of this century.  Use of any computer aided drafting 
software requires an understanding of analog 
methods as many of the tools and functions used in 
design software are based directly or conceptually 
on analog tools and techniques used for on-site 
measurement, construction, or fabrication. The 
digital medium has also produced its own new 
methods for measuring, drawing, and modeling 
geometric forms which are based largely or entirely 
on the logic of computation rather than physical/ 
gestural/ mechanical analogs. 

Which Program Should I Use?
The following section outlines tools and techniques 
for drafting using a digital, CAD-based process. 
While the tools and techniques are specific to 
digital drafting in AutoCAD and Rhino, the same 
processes would apply when using other CAD 
related software. Understanding the strengths and 
weaknesses of each program will help you better 
understand when to use them and how to best 
incorporate them into your design process. 

Key Terms

AutoCAD

Rhino

viewport

units

layer

command

template

model space

paper space

layout

detail

scale

plot

a 2D and 3D computer-aided design and drafting soft-
ware developed by Autodesk

a 2D and 3D computer-aided design software developed 
by Robert McNeel & Associates

a window on screen that displays a specific view

property of measurement in a drawing or model, typical-
ly referring to digital workspaces 

a system of organizing objects and lineweight in digital 
software

terms that are used to direct drawing and editing oper-
ations in command based softwares like AutoCAD and 
Rhino

a file with preset settings, styles and layouts

infinite workspace in digital drafting and modeling soft-
ware

in AutoCAD, where the scaled version of a drawing is 
placed to simulate the actual piece of paper it will be 
printed on.

in Rhino, where views of a model or drawing are placed 
at different scales to simulate a printed document(s)

in Rhino, the view of a model or drawing within a layout

a way of representing large objects in a smaller size that 
is still measurable and accurate

refers to both a large scale print and a command for 
exporting and printing drawings
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Digital Tools
The tools listed below are aids to manage the 
precision and tolerance of orthographic line 
drawings. 

Operating System
The following examples are specific to Rhinoceros 
3D (Rhino) and AutoCAD, but are largely standard 
features for most drafting or design programs.  

Mouse
Like several other design programs, a computer 
mouse is absolutely necessary to properly use 
AutoCAD or Rhino. The program will function 
without one, but navigating a model will prove 
difficult and time intensive. Wired and wireless 
mice both work well, and a center scroll wheel will 
save you a lot of time in zooming in and out. Just 
use a mouse.

Getting Started
 
Start a new file. Name and save following the 
suggested File Management conventions found in 
the Documentation section of this manual. 

Model Space vs Paper Space
Model space is where you are working at full scale 
and in some programs, where you are actively 
manipulating a design model in three dimensions. 
Layout space is where you can specify 2D drawings 
or views for printing at specific architectural scales.

Using Layouts
Layouts in Rhino or AutoCAD are used when 
you want to preserve the scale, view and view 
extents of a particular drawing to export as a PDF 
or raster image. The Layout space is also where 
drawing annotations, dimensions, scales, and other 
architectural symbols can be added to the drawing 

and can remain separate from the model space.
Layouts can be used to output individual drawings 
to be used later in a program like Adobe InDesign, 
or can be composed within the layout itself to show 
multiple details and views of your drawings or 
digital models.

The real benefit of using a Layout is that it allows 
for the testing and calibration of line weights, types, 
and colors. Once established, these settings will 
allow you to focus on the drawing itself by simpli-
fying the process of editing, testing, and outputting 
drawings.

Unit Settings
When first opening Rhino or AutoCAD, you will 
be prompted to determine whether your model 
space is based on Metric (meters and millimeters) 
or US Imperial dimensions (feet and inches). In 
general, projects constructed outside of the United 
States, use metric units. Canada, although officially 
a metric country, has a mixed system, sometimes 
using metric and sometimes using U.S. imperial for 
projects.

In drafting and modeling programs like Rhino and 
AutoCAD there are pre-set model-space templates 
for both systems. It is also possible to change the 
model space units of a working file at any time.

What Unit Should You Draw In?
In general, it is recommended that you choose a 
unit appropriate to the smallest level of detail or tol-
erance you want to draw at.  When drawing a site-
scale plan, for example, you may choose to work in 
meters or feet. When drawing at the architectural 
scale, it may be easier to work in increments of 
inches or millimeters, although this is a matter of 
preference.
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Tools & Best Practices: AutoCAD

Why AutoCAD?
AutoCAD is a recommended software program for 
digitally developing and exporting 2D drawings as it 
has several functions that make it easier to visual-
ize and control lineweights and layouts. Drawings 
can be constructed entirely in AutoCAD, or base 
linework can be exported from Rhino as a .dwg 
file and opened or inserted into AutoCAD. Unlike 
post-processing drawings in Illustrator, AutoCAD is 
a fully functional drafting program, so lineweights 
can be set throughout the process and drawings 
can continue to be developed. Exporting or printing 
a drawing for a desk crit is one command away, 
encouraging iteration and saving you a lot of time 
in your workflow.

Program Download
AutoCAD is free for students by creating an Au-
todesk educational account with your university 
email at: https://www.autodesk.com/education

Several years of AutoCAD will be available. The 
most recent year is recommended, but any should 
work for most applications. Some versions may 
include a ‘Produced by an Autodesk educational 

product’ label when exporting drawings. If this 
label does appear, it can be easily deleted in Adobe 
Acrobat when viewing your exported PDF.

Operating System
The examples presented here are shown in Au-
todesk AutoCAD for Windows. AutoCAD is also 
available for macOS, but was initially developed and 
for many years was only available for Windows. 
The interface and location of some commands and 
settings will be different on macOS, but the con-
cepts are all the same. It is recommended that you 
use AutoCAD for Windows, for ease of use working 
between programs.

Commands
AutoCAD functions with toolbar buttons to activate 
commands, but also a command prompt (along the 
bottom of the screen by default) to type commands. 
Toolbars are helpful to find new command and 
learn them, but typing commands will prove the 
fastest, so it is recommended to try this mode of 
working from the beginning.

Workspace

Viewports
AutoCAD as a 2D drawing program works exclu-
sively in the default top view. This one viewport fills 
the entire screen and is the only view you will need 
while drafting.  

Workspace Appearance Settings
It is helpful to customize AutoCAD’s default visu-
alization settings to suit your preferences, and to 
have drawings look closer to their finished state 
while drafting. Most settings can be changed with 
the preferences command, which will open the 
AutoCAD Options dialog box, accessed by typing the 
Options command and pressing Enter.

LinkedIn Learning:
The AutoCAD 2023 
Interface
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Drafting Commands

Utilities
Units

Pan
Properties
Layer
MView
Plot

Creating
Line
Pline
Rectangle
Circle
Ellipse
Polygon
Arc

Editing
Move
Copy
Trim
Extend
Scale
Rotate
Mirror
Offset
Array
Join
Hatch
Pedit
Explode
Group
Ungroup
Qselect

(Bold letters indicate shortest keystrokes)

Sets the display formats for coordinates, distances 
and angles.
Pans the drawing.
Opens properties panel.
Opens layer properties panel.
Creates and controls layout viewports.
Plots a drawing to a plotter, printer, or file.

Creates a line with two points.
Creates a line/curve with multiple points.
Creates a rectangle with specified length and width.
Creates a circle from specified radius.
Creates an ellipse from length and width radius.
Creates a polygon with specified number of sides.
Creates an arc from a combination of points.

Move selected objects.
Copy selected objects.
Trim lines from selected cutting boundaries.
Extend lines to a selected boundary.
Scale selected objects.
Rotate selected objects.
Mirror selected objects.
Offset selected lines a specified distance.
Creates an array of selected object.
Joins lines together.
Hatches a pattern in a closed area.
Edit single/multiple polylines.
Explodes a polyline into segments.
Creates a set of objects that will be selected as one.
Makes group of objects individual objects again.
Creates a selection set by filtering object type and 
property.

Best Practices
Purge

Overkill
Matchprop

Redraw
Regen

Attach

Removes unused items (layers, blocks etc.) from 
drawing.
Removes duplicate/overlapping lines.
Applies properties of a selected object to other 
objects.
Refreshes display in all viewports.
Regenerates the drawing from within the current 
viewport.
Inserts references to external files.
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AutoCAD Modelspace 
Workspace.

File Tabs

Command Prompt
Modelspace &
Paperspace Tabs

Coordinate System

Snaps Scale

Modelspace/Paperspace

Toolbars Layers View Cube

Cursor
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In Options>Drafting>AutoSnap Settings>Colors... 
you can change the Uniform Background color to 
white. This is recommended so that drawings will 
look as close as possible to their printed state on 
white paper while drafting.

In Options>UserPreferences>Windows Standard 
Behavior>Right-click Customization... find and 
check the box for Turn on time-sensitive right-click. 
This will mean that right-click will automatically 
begin enter into the most recently used command. 
This makes it very fast to quickly repeat a certain 
command many times. Holding right-click for a few 
seconds will still open the normal right-click drop-
down menu.

Units
When opening a new file in AutoCAD, you will be 
given the option to select a template. The default 
“acad” template will do, and should automatically 
set your file units to inches. If you need to work in 
metric, the “acadiso” template will set your units to 
millimeters.

Options>
Drafting>
AutoSnap Settings>
Colors...

You can change how units are visualized (decimal, 
fraction, etc.) using the units command.

Drawings in AutoCAD are usually drafted at full 
scale, meaning that a 3’ hallway will measure 3’ in 
AutoCAD when measured with the distance com-
mand. This makes it easy to think about the actual 
size of your design and to input the real world di-
mensions when drawing. Drawings can be scaled to 
a specific architectural scale when exporting, which 
will be discussed in detail below.

Model Navigation
Your model can be navigated using commands, but 
it is best to learn to do this quickly with your mouse 
and a few keyboard shortcuts:	
	 Pan: mouse wheel click+drag
	 Zoom: mouse wheel scroll

Options>
User Preferences>
Windows Standard Be-
havior>
Right-click
Customization...

LinkedIn Learning:
Working with Pallets and 
Dialog Boxes

Default Templates.
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Mouse wheel click+shift+drag will orbit the viewport 
into 3D view. If this happens by accident, you can 
use the View Cube on the screen to navigate back to 
top view.

Selecting Objects
Objects in your model can be selected by left-click-
ing. If objects are closely overlapping, AutoCAD will 
select the top object.
Left-clicking on the screen but not on an object 
will mark the corner of a selection box that will be 
closed by left-clicking again. Clicking to the right 
will produce a blue selection box with a solid line 
edge, and only objects entirely inside the selection 
box will be selected. Clicking to the left will produce 
a green selection box with a dashed line edge, which 
will also include any objects partially inside the 
selection box.

Left-click+drag is used to freeform select (lasso) an 
area, and the same rules for dragging to the right or 
left apply.

Units menu.

LinkedIn Learning:
Setting Drawing Units

LinkedIn Learning:
Using Zoom and Pan

Layers & Lineweights

Layers
Like many other design programs, AutoCAD func-
tions with a series of layers in which various objects 
are created. In AutoCAD, layers can be used strate-
gically to set lineweights.

Before beginning to construct your drawings, 
you should set up layers for your lineweights. To 
keep your drawings and file organized, you should 
always set lineweights by layer and not by individ-
ual objects. If you need to edit your lineweights at 
any point, this can easily be done with the layers 
panel, and you won’t need to remember to go back 
and manually change individual lines and objects in 
your drawing. To confirm your lineweights are set 
by layer, select your drawing and in the Properties 
panel, make sure that ‘Linetype,’ ‘Print Color,’ and 
‘Print Width’ are all set to ‘By Layer.’

If you need to reassign the layer of all objects on a 
particular layer, you can use the quickselect com-
mand (QSelect) to select all objects on a single layer 
and reassign them to a different layer.

Lineweights
In the Layers panel, you can create a new layer for 
each lineweight in your drawing, and set the color, 
linetype, and print width for each of these line-
weight layers. For lighter lineweights, lowering the 
lineweight and also changing the color to a lighter 
gray instead of black is an effective strategy. When 
you make your drawing and need to assign line-
weights to lines, you can simply select those lines 
and add them to the proper layer you just created.

To help visualize your heavier lineweights on the 
screen, use the command LWdisplay and set it to 
ON. This will artificially thicken lineweights above a 
certain threshold, usually around 0.30mm. To more 
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LinkedIn Learning:
Using the Layer Tools

LinkedIn Learning:
Changing Linetype Scale

Layers Properties Managerd accurately view your lineweights relative to the 
final drawing, you can view and even continue 
working on your scaled drawing in a Paperspace 
print layout, as discussed below.

Layouts & Printing

Layouts
AutoCAD allows you to work on your drawings at 
full scale in what is called ‘Modelspace.’ You will 
know you are working on your drawing in Model-
space when the ‘Model’ tab at the bottom left corner 
of your screen is selected. AutoCAD also allows you 
to setup and work in ‘Paperspace,’ in which you set 
the paper size and scale for your drawing(s). This 
means you can visualize all lineweights accurately, 
and also print directly from your Paperspace layout.

Paperspace layouts will also be visible in the bottom 
left corner of your screen next to the ‘Model’ tab. 
These tabs will be labeled ‘Layout,’ and you can 
create new layouts, rename them, and change their 
settings here.

To edit a Paperspace layout, right-click on the 
layout tab you want to edit and select ‘Page Setup 
Manager...’. The pop-up window will allow you to 
see a list of your layouts and their page sizes and 
basic settings. You can click ‘New...’ to create a new 
layout or click the layout you want to edit and click 

‘Modify...’.

This will open another pop-up window in which 
you can customize your layout. The following set-
tings are the most commonly used:
-	 Printer/plotter: Recommended to set to ‘DWG 

to PDF.’ This will create and save a PDF file 
when you use the ‘plot’ command to print. It 
is also possible to set this to print directly to a 
printer or plotter, but is not recommended as 
Acrobat will streamline PDF files for printing

-	 Paper size: Select the page size you will be 
printing on. You can create custom page sizes 
for plotting by clicking on the ‘Properties’ 
button next to the printer name, and choosing 
‘Custom Paper Sizes’ and ‘Add...’ to create a 
custom size.

-	 Plot area: Leave this set to ‘Layout.’
-	 Plot scale: Make sure this is set at ‘1:1.’ It is 

better to set scale through your drawing. 

Paperspace layout.
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-	 Plot options: These should be fine left with the 
default settings.

-	 Drawing orientation: Select ‘Portrait’ or ‘Land-
scape’ as desired.

Drawing Placement & Scale
Once your layout is created with paper size, etc. you 
can position and scale your drawings on the page. 
You can place one or multiple drawings on the page 
by using ‘viewports’ that reference your drawings 
in Modelspace. To create a new viewport, type the 
MView command. You can move and resize this 
viewport as you would any rectangle or line object.

Page Setup Manager.

Page Setup.

You can zoom to your drawing by double-clicking 
within the viewport, or by clicking the ‘PAPER’ 
button at the bottom of the screen to change it to 
‘MODEL.’ You can toggle this button again or press 
the esc key to switch back to paper mode. You will 
see that this allows you to toggle between zooming 
in and out on the page/layout vs. zooming in or out 
on the drawing within a viewport.
To accurately set the scale of a drawing within a 
viewport, select the viewport rectangle and select 
a scale from the list at the bottom of the screen. 
You can also create custom scales by selecting 
‘Custom...’ at the bottom of the list. Once your place-
ment and scaling of the drawing is set, you can click 
the padlock icon next to the selected scale in order 
to prevent accidental rescaling.

You will notice that all lineweights will be accurately 
displayed once the drawing size and scale are set. 
You can either reference this as you continue to 
work on your drawings in Modelspace, or work on 
them directly in Paperspace - just make sure you 
are drawing in the model viewport and not on the 
paperspace layout.

Creating custom page 
sizes.

LinkedIn Learning:
Defining Your Page Setup

LinkedIn Learning:
Adding Scaled Viewports
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Viewport scale options & 
lock button at bottom left.

Printing
Once all these settings are established, you can 
quickly and easily print your drawings either to 
a PDF file or directly to a printer or plotter by 
using the Plot command when you are viewing the 
desired Paperspace layout tab. It is usually recom-
mended to print to a PDF file and then use Adobe 
Acrobat to print your PDF to a printer or plotter.

Using and Printing Lineweights
Like stated in the drafting chapter, an architectural 
drawing typically has about 5 lineweights. The size 
and scale of a drawing will dictate the spectrum of 
line weights that are appropriate. These lineweights 
are commonly used and a good starting place, how-
ever, it is important to always test print and adjust 
to find out what works best with the scale you are 
working in.

LTScale
LTScale is a scale factor used in controlling the 
scale of linetypes in drawings. If this scale is 
changed, the appearance of linetypes in drawings 
change. If the LTScale is set to 1, dashed lines will 
be specified in the same units as the drawings. It is 
important to consider what scale a drawing will be 
printed at when selecting an LTScale since the LTS-
cale will scale down with scaling of a drawing. Since 
most architectural drawings will be at a scale much 
smaller than the actual object, it may be necessary 
to try out increasing the factor of the LTScale for 
visibility of dashed lines. If dashed lines are at a 
LTScale that is too small, they will appear as solid 
lines. 

CTB Plot Style
CTB is a color dependent plot style, which is stored 
in .ctb files. CTB plot styles creates a relation-
ship between the color of a layer and the printing 

thickness of a lineweight. CTB is commonly used in 
architecture firms, where standardization between 
complex drawings across the office and with collab-
orators is necessary. CTB files are not conducive to 
viewing lineweights as you draw, and are unneces-
sary when lineweights are set by layer.
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settings.

LinkedIn Learning:
Printing and Plotting
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Construction lines:
Lightest lineweight. Show 
relationships between ele-
ments and drawings.

Dashed lines:
Light or medium lineweight. 
Show object above cut line.

Section cut lines:
Heaviest lineweight. Show 
objects being cut through.

Hatch/paving pattern:
Used to show material qual-
ity or spatial hierarchy.

Medium elevation lines:
Show closest elements after 
cutting plane.

Light elevation lines:
Show detail elements or 
those in distance including 
furniture and fixtures.

Extra light elevation lines:
Show smallest detail 
elements or those farthest 
away.

Example lineweight display 
in paperspace layout.
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Tools & Best Practices: Rhinoceros

Why Rhino?
Rhino is most well known for its 3D modeling tools, 
however it is also equipped with drafting tools for 
developing and exporting 2D drawings.  One of the 
benefits of drafting in Rhino is the ability to test 
aspects of the design in 3D within the same file.  As 
in AutoCAD, lineweights and linetypes can be set 
within the program, allowing for exporting and 
printing directly from the layouts without addition-
al post-processing work. 

Operating System
The examples presented here are shown in Rhinoc-
eros 7 or 8 for Windows. Rhino is also available for 
macOS, and is very comparable in performance to 
the Windows version. The interface and location of 
some commands and settings will be different on 
macOS Rhino, but the concepts are all the same. It 
is recommended that you use Rhino for Windows, 
for ease of use working between programs, many of 
which were developed primarily for Windows.

Program Purchase
Educational licenses for Rhinoceros 7 and 8 are 
available at a discounted rate.  90 day free trials are 
also available of the latest release. 

Commands
Like AutoCAD, Rhinoceros is a command based 
software, meaning that many tools are available 
to you within toolbars and icons present on the 
screen, but also through the command prompt, into 
which you can type commands to activate tools and 
input dimensions, angles, and other information. 
The toolbars are sorted by type of operation or 
element, so are very helpful in locating commands, 
especially when you are new to the software. 

You can begin typing a command either before or 
after selecting objects, by simply typing on the key-
board. You will see your typing appear in the com-
mand prompt line near the top of your screen. You 
do not need to click on or select this bar before you 
start typing. Once you start typing a word, Rhino 
will provide a dropdown list of possible commands 
that sound similar or are related to the word you 
are typing – this is very useful to find new com-
mands that do specific things.

Once you type the command or select it from the 
provided list, press enter and the command prompt 
will help to walk you through the command. This is 
a great way to discover new functions within com-
mands, or to learn how to use new commands.

In the example provided, the Line command has 
been entered, and Rhino asks for Start of line, 
prompting you to click in one of the viewports to 
select the point where the line starts. Rhino also 
provides a series of options that change how the 
line is created, and you can select any of these 
options by either clicking on it in the command 
prompt or by typing the underlined letter in your 
chosen option and pressing enter (in this case for 
example, B will create a line that extends in both 
directions from the start point).
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Drafting Commands

Utilities
DocumentProperties
Save As		
ZoomSelected 
(ZS)	

Measuring
Distance (DI)
Length 
Area (A)		

Creating - 2D
Point
Line (L)
Polyline (PL)
Curve
Rectangle
Circle
Ellipse

Editing
Move (M)
Copy (C)
Trim (TR)
Split (SP)	
	
Extend (ET)
Scale (S)
Scale1D (S1)
Rotate (RO)
Mirror (MI)
Offset (OF)

Array (AR)
ArrayCrv	
CloseCrv (CC)
Explode (EX)

Join (J)
Group (GR)
Ungroup
Hatch

Hide (H)
Show (SH)

Best Practices
Save (Ctrl+S)
Undo (Ctrl+Z)
Purge (PU)

SelDup+ Delete
MatchProp

(Possible Aliases and shortcuts in parentheses)

Opens the document properties menu
Creates a copy of the current file
Focuses to selected objects

Find distance between two points
Find length of a line
Find area of 2D shape

Draws a point
Draws a line with two end points
Draws multiple lines connected by points
Draws a curve with control points
Draws a rectangle
Draws a circle from center and radius
Draws an ellipse with two defined radii

Moves any object
Copies any object
Trims intersecting objects
Divides objects into parts using a splitting line or 
object
Extend lines to a selected boundary
Scale selected objects
Scales in one dimension
Rotates an object on xy plane
Mirrors an object about an axis
Offsets a curve from original location a specified 
distance
Arrays an object in x, y, and/or z axis
Arrays an object along a line or curve
Closes an open curve
Explodes an object into its parts

Joins objects that are touching
Groups objects to be selected together
Ungroups objects that are grouped
Fills the space within a boundary curve with a 
pattern
Hides objects from view
Shows hidden objects

Saves a copy of your file
Undo the last change or command
Removes unused items (layers, blocks etc.) from 
drawing.
Selects duplicate/overlapping lines for removal.
Applies properties of a selected object to other 
objects.
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Rhino Modelspace -  
2D Drafting Workspace.

Command Prompt

File Units & Active Layer Drafting Aids

Active/ Maximized Top View 

Common Drafting Commands

Modelspace Views 
& Layout Tabs

Object Properties

Line Type Print Color & 
Width

Object Snaps

Layers TabDrafting Toolbar
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The vast majority of 2D commands in Rhino are 
the same as in AutoCAD, but a few of the shortened 
commands will be different (for example, MI will 
mirror in AutoCAD, but minimize the program in 
Rhino). It is recommended to update these short-
ened commands with Rhino aliases so that your 
workflow can be the same in both programs.

Aliases
You will find over time, once you familiarize your-
self with the names of commands and their results, 
that typing commands is much faster. Since you 
will often repeat commands many times when con-
structing a drawing or building a model, this small 
amount of time saved can have a significant effect 
on overall drawing or modeling time. 

Aliases are essential to working efficiently within 
any CAD modeling or drafting software. Rather 
than typing out the entire command name,
two or three letter combinations can activate the 
operation and save you valuable time. Many pro-
grams contain default aliases, but you can custom-
ize them to suit your workflow. Below are a few of 
the default aliases in Rhino:

	 M	 _Move
	 O	 _Ortho
	 ZS	 _ZoomSelected
	 POn	 _PointsOn

For common commands, you can add custom 
aliases one by one to Rhino within the 'Aliases' 
menu in 'Document Properties' or you can import 
a text file containing a longer list. For instance, if 

you are partial to AutoCAD, you can import those 
drafting aliases into Rhino to unify the commands 
across programs. When adding aliases, it is import-
ant to not only consider an intuitive abbreviation, 
but also the position of your fingers on the keyboard 
and the proximity of certain keys to each other. 
Aliases should not require you to reach awkwardly 
across your keyboard or input complex and lengthy 
abbreviations. They also cannot repeat, so you will 
have to consider which commands you use the most 
and abbreviate as needed.  Refer to the Drafting 
Commands page within this section for alias sug-
gestions. 

Workspace

Viewports
The Rhino workspace by default consists of four 
viewports: Top, Perspective, Front, and Right.  As in 
AutoCAD, it is recommended to use the Top view-
port for all 2D drafting.  Double-click on the Top 
viewport to maximize the view to full screen.  

Workspace Appearance Settings
It is helpful to customize Rhino’s default visualiza-
tion settings to suit your preferences.

File>Properties will open the Document Properties 
dialog box. In this box under Rhino Options>Ap-
pearance>Colors, you can set the Background color 
to white or light gray. This will more closely mimic 
the appearance of your drawings when printed on a 
white page.

Units
Drawings in Rhino are usually drawn at full or 1 to 
1 scale. Units can be changed under File>Properties 
(opens Document Properties dialog box)>Units>-
Model. Here you can switch between feet, inches, 
meters, and other units, and also select the display 
preference for fractions or decimals.

Line command options.

Linkedin Learning:
Viewport Navigation
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When units are changed, Rhino will provide the 
option to automatically scale all objects in the file. 
This is helpful if you had been drawing in meters 
but meant to be in feet, for example.

Setting your units to feet versus inches will have an 
effect on how you input dimensions when drawing. 
If set to inches, you can input dimensions in inches 
with just numbers (12 = 12”), but will need to input 
dimensions in feet by specifying the units (12’ = 12’), 
and vice versa if units are set to feet (12 = 12’ and 
12” = 12”).

When creating a new file in Rhino, you will have the 
option to choose from several templates with preset 
units. The “Small Objects” versus “Large Objects” 
options will only effect the default tolerance when 
taking measurements. It is suggested to begin with 
“Small Objects – Inches” or “Small Objects – Feet.”

Model Navigation
Your drawing can be navigated using commands, 
but it is best to learn to do this quickly with your 
mouse and a few keyboard shortcuts: 

Orthographic viewports:
	 Pan - right click & drag 
	 Zoom - mouse wheel
		  or Ctrl+right-click+drag

Selecting Objects
Objects in your model can be selected by left-click 
ing on them in any viewport. If objects are closely 
overlapping, Rhino will sometimes provide a small 
dropdown menu for you to select which object to 
select.

Left-click+drag is used to select multiple objects. 
Dragging to the right will produce a selection box 
with a solid line edge, and only objects entirely 
inside the selection box will be selected. Dragging to 
the left will produce a selection box with a dashed 
line edge, which will also include any objects par-
tially inside the selection box.

Linkedin Learning:
Setting and Fixing Rhino 
Preferences

Selecting file units from 
template file options.

Linkedin Learning:
Selecting Objects

Document Properties

Document Properties>
Appearance>
Colors>
Viewport colors
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Snaps
Along the bottom and side of the Rhino workspace, 
you will find a toolbar with several snapping op-
tions.  You'll find many of these options particularly 
helpful when drafting or modeling in Rhino.  The 
snaps listed below are the most critical for drafting 
in Rhino.  Refer to the Digital Modeling section for 
additional snaps options. 

Grid Snap
Grid Snap will automatically move your cursor 
to the closest point on an invisible grid in each 
viewport. This is usually limiting, but can be helpful 
in certain situations. You will likely find yourself 
working with Grid Snap turned off most of the time, 
but don’t forget it is there when working with a grid 
with uniform spacing may be advantageous. The 
size of the Grid can be changed by right-clicking on 
Grid Snap and choosing Settings… from the drop-
down menu.

Ortho
When Ortho is turned on, movement of the cursor 
when using a command will be limited to the 
orthogonal directions (x, y, and z axis). This is very 
helpful, and can be toggled on and off on the fly. You 
can also temporarily bypass the Ortho snap in the 
middle of a command by holding Shift. If Ortho is 
turned off, holding Shift will temporarily enable it.

Osnap
Osnap is short for Object Snap, an incredibly useful 
tool that will insure you are connecting objects pre-
cisely with zero tolerance. There are several Osnap 
options that can be individually enabled/disabled.  
The ones listed below are most commonly enabled 
when drafting:
End – endpoint
Mid – midpoint
Cen – center of curve/surface

Int – intersection
Perp – point of perpendicular intersection
Tan – tangent point
Quad – quadrant point (maximum x/y coordinates) 

of circle or ellipse
Project – this option projects the point you are 

snapping to onto the Rhino construction plane 
(xy plane by default)

SmartTrack
SmartTrack is a function that will create impromp-
tu guidelines to snap to. When SmartTrack is en-
abled, this guideline can be created automatically by 
hovering the cursor over an Osnap point, or manu-
ally by pressing Ctrl.

Layers and Lineweights

Layers
Like many other design programs, Rhino works 
with a layer system that is used to organize and 
structure your models and drawings. The layers 
menu can be found on the right side of your Rhino 
workspace under a tab with an icon that looks like 
a slice of red, white, and blue cake. All your layer 
settings can be controlled from this menu.

Linkedin Learning:
Selecting Objects
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Before beginning to construct your drawings, you 
should set up layers for your lineweights. To keep 
your drawings and file organized, always set the 
lineweight by layer and not be individual objects.  
By clicking on Continuous under the Linetype 
column, a menu of available linetypes will pop up.  
Several common linetypes can be accessed here.  
You can also create custom linetypes in File>Docu-
ment Properties>Linetypes.  This location will also 
show you the specific scale of the dash patterns for 
each linetype.  

The square to the left of the Linetype column spec-
ifies the color of the linework in Model Space and 
the diamond to the right specifies the color your 
linework will print to.  Typically print colors are set 
to black or potentially to another gray-scale value. 

Print Width controls the width of the line when 
printed - commonly referred to as the line weight.  
The number indicates the thickness of the printed 
line in millimeters.  When changing this setting, 
even with the 'Print Preview' setting activated, you 
will likely see little, if any, change in the lineweight 
on your screen in Rhino.  This is a limitation of the 
software and you will need to conduct multiple test 
prints to calibrate your lineweights. 

Settings
The visibility of layers can be toggled with the light-
bulb icon, and the ability to select layers can be tog-
gled with the lock icon next to each layer name. The 
display color of all objects on a layer can be changed 
by clicking on the colored box just to the right of the 
lightbulb and lock icons.

New layers can be created with the page icon at the 
top, and layers can be renamed by right-clicking on 
their name and selecting Rename Layer from the 
dropdown menu (this will not work if you are in the 
middle of a Rhino command – if this happens, use 
Esc to cancel the command and try again). Layers 
can be rearranged by dragging them around or by 
using the arrow icons at the top. Layers can also be 
nested into other layers as sublayers which is help-
ful for keeping files with many layers organized, 
and to be able to easily toggle visibility and locking 
of many sublayers at once.

Setting Layer Linetypes & 
Print Widths

Layers menu
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Assigning Object Layer
The check mark next to a layer name indicates the 
currently selected layer. New objects created in 
Rhino will automatically be assigned to the current 
layer. There are also two ways to change the layer of 
an existing object:

-	 Select the object(s) then right-click on the layer 
you want to assign the object(s) to. From the 
dropdown menu, choose 'Change Object Layer' 
or 'Copy Objects to Layer'.

-	 Select the object(s). Under the 'Object Proper-
ties' menu tab located next to the Layers menu 
tab, select the Layer to assign the object to from 
the Layer dropdown list.

Layouts & Printing

Layouts
At any time when drawing in Rhino, you can use 
the Print (Ctrl+P) command to print a drawing.  
When used in Model Space, the command will cap-
ture the current contents of your active viewport.  
Printing directly from Model Space however can be 
difficult to scale and will produce an inconsistency 
in the placement of the drawing on the page.  This 
will be problematic to work with if you are trying to 
iterate or build up the complexity of a drawing over 
time. 

Using a layout is the best way to precisely scale the 
output of your drawing, maintain consistency in 
the output location of your drawing, quickly change 
or edit the paper size of drawing output, and add 
annotations, symbols, titles, and dimensions to a 
drawing. 

Creating a Layout

Layout Settings

Object Properties menu.
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When starting a new drawing in Rhino, if you 
intend to print from a layout, you will need to create 
one by clicking the '+' icon on the bottom left of 
the workspace.  This will open a dialog box where 
you can choose the size of the layout, the 'Printer' 
(which can be set to Adobe PDF or Rhino PDF), and 
allow you to name the layout.  It is recommended to 
name the layout something that helps you identify 
either the drawing type you will be outputting from 
the layout (e.g. "plan," "section," "elevation,", etc) or 
the size of the layout, or both.  All of these settings 
can be adjusted later by simply right-clicking the 
name of the layout you created and accessing the 
'Layout Properties.' 

The Detail
When you create a layout in Rhino, it will automat-
ically create a Detail.  The Detail will appear along 
with a gray rectangle that represents the paper size 
of the layout.  The area within this gray box is what 
will be captured by the Print command. 
Like other Rhino geometry, the Detail can be 
moved, copied, rotated, scaled, or deleted.  Multi-
ple details can also be added within a single print 
Layout.  The Properties of the Detail can  be ac-

cessed to precisely scale your print output.  Printing 
drawings to scale is an extremely important skill to 
build into your practice.  

The Detail will be created on whichever layer is 
active when you created the layout.  It is advised 
to create a new layer called 'Detail' to organize this 
specific type of geometry and keep it separate from 
other drawing layers.  The detail has several im-
portant properties, including the ability to control 
the scale of the view it displays. 

When any geometry in Rhino is selected, the prop-
erties tab will display information, including what 
layer it is contained within, as well as information 
about how it is being displayed, how it will print, 
and even details about its specific data type and 
location within the Rhino model space.  Selecting 
the Detail when in the Properties panel will create 
a special dialog box (the small paper-shaped icon) 
that will allow you to precisely control the scale of 
your drawing output.  Here, you should attempt to 
set your drawing scale to something that works well 
with your drawing units and frames your drawing 
nicely on the page.  You can also set the detail to 
'Locked,' which will prevent you from inadvertent-
ly changing you set view location or scale.  In this 
example, the drawing scale is set to 1/8"=1'-0" or 1 
inch on the layout in Paper Space is equal to 8 feet 
in Model Space.  

Detail Properties

Adjusting Layout Units



Production Manual  |  7170  |  University of Virginia School of Architecture

Printing
Once your drawing scale is established and your 
linetypes, lineweights, and print colors are speci-
fied, you can quickly and easily print your drawings  
to a PDF by typing Print or Ctrl+P or navigating to 
File>Print.  You also have the option to print directly 
to a printer, however it is advisable to print first to 
PDF to check your lineweights and optimize the file 
for printing. 

Once you hit Print, the Print menu will pop up. 
Within the 'Destination' submenu, first specify 
the printer, in this case AdobePDF, page size, and 
orientation.  The page size should correspond to 
your layout dimensions, in this example Letter size 
or 8.5"x11".  Next specify page orientation to either 
Portrait or Landscape, again matching your layout.  
The preview window adjacent to the settings will 
adjust as make changes.  For 'Output Type' specify 
'Vector Output' and for 'Output Color' specify 'Print 
Color'.  This ensures that your linework will be crisp 
and match the colors you specified in your layer 
settings.  Within the 'View and Output Scale' menu, 
make sure your layout is selected and that the scale 
is 1:1.  There are three additional submenus, but 
their default settings typically do not need to be 
adjusted.  When finished making adjustments, hit 
the 'Print' button in the lower left corner.  This will 
prompt you to save the file.  Remember to include 
the date and relevant title in your file name prior to 
saving.  

Rhino Print Menu
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Architectural Modeling

Why Model?
Models, physical or digital, are essential to the 
design process. Their scale and scope shift in 
relation to spatial, tectonic or material inquiries, 
providing a three dimensional format for the visu-
alization and simulation of architectural elements 
and assemblies. They are a medium within which 
plan and sectional ideas are tested and where the 
intersections of spaces and elements are negotiated 
and refined. Whether they are created for explora-
tion or representation, they provide an experiential 
and familiar means for observing and evaluating 
architectural form and space. 

Physical concept models are an integral part of the 
design process, allowing for quick, yet precise, ex-
plorations of organizing spatial ideas and systems. 
They serve as a generative tool, initiating a feedback
loop of design development, evaluation, and revi-
sion. This ability to work in iteration is essential to 
exploring a set of design ideas and moving a project 
forward. Consistency in scale, medium and method
allow for comparative analysis of design iterations, 
however variations in technique, material, and 
resolution can result in new readings (and misread-
ings) of proposed spaces and structures.

a three-dimensional representation, esp. on a small scale, 
of a person or thing or of a projected or existing struc-
ture; esp. one showing the component parts in accurate 
proportion and relative disposition

a procedure in which repetition of a sequence of
operations yields results successively closer to a desired 
result

1. Any raw material or mode of expression used in an 
artistic or creative activity 2. an intermediate agency, 
instrument,or channel; a means; esp. a means or channel 
of communication or expression

A continuous extent having only two dimensions (length 
and breadth, without thickness), whether plane or curved, 
finite or infinite; an entity such as constitutes the bound-
ary of a solid object or separates two adjacent portions of 
space

a 3D object made from a base plane or curve

two or more surfaces joined together, often to create a 
solid

line expressing the subdivisions of a surface

a surface or polysurface that encloses a volume

often a solid, can be thought of as watertight, with no 
open edges or missing faces. A closed line is any closed 
2D shape, where the start point is touching the end point

a solid object is open if it has missing faces, a curve is 
open if its end points do not connect

Key Terms

model

iteration

medium

surface

extrusion

polysurface

isocurve

solid

closed (geometry)

open (geometry)
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Digital modeling allows for conceptual formal, 
spatial and material explorations often at 1 to 1 
scale.  Working within a digital environment allows 
for the translation of 2D geometry (points and lines) 
to 3D surfaces and volumes, offering designers a 
way to digitally inhabit the space of their proposals. 
With these advantages comes possible limitations. 

Digital model space is weightless and infinite, 
causing the apparent suspension of objects 
and omission of gravitational loads and forces. 
Tectonics can quickly become an afterthought and 
unnecessary scales of investigation can be pursued. 
Digital models can easily become complicated and 
contain massive amounts of information. It is 
imperative to recognize the level of detail required 
of your investigation and to only model what is 
needed. Remember, the 3D model is not the project. 
It is one of the many tools used to develop a design 
idea and does not have to include every detail of the 
design.

Study Models by Abduref 
Hussien, UVA SoA ARCH 
3020 Studio

Translation of 2D Linework 
to 3D Geometry in Rhino
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Physical Modeling:  Tools & Materials

Why Physical Model?
Modeling by hand and with easily manipulatable 
materials can enable a quick and focused investi-
gation of spaces and structures. It is important to 
keep in mind that study models are not precious. 
They are a way of actively working through a design 
idea and can reflect the process, similar to a sketch.  
The following section includes common materials 
and tools for working precisely and efficiently with 
physical models.

Sheet Materials
In most planar model making applications, Bristol 
paper and chipboard are the most common materi-
als, but other paper sheet materials are commonly 
available and can be good for specific techniques.

Papers
Thick, smooth, matte finish white papers such as 
Bristol are great for making paper models. They are 
easy to cut cleanly and are thick enough that they 
can be scored for folding but flexible enough to also 
make curving surfaces. The relatively thin edge 
means that care should be taken to not over-apply 
glue. Thick papers in various colors and textures 
can be used to great effect in a model but can also 
be distracting from the overall form if not used in 
intentional ways – they are usually reserved for 
special applications only.

Bristol paper.

Chipboard
Chipboard comes in a variety of colors (usually 
brown, gray, and white) and thicknesses (commonly 
1/32” or 1/16”, and up to 1/8”). The various thick-
nesses are sometimes referred to as single-ply, 
double-ply, or triple-ply. It is usually best to use 
chipboard that is the same color on both faces 
except under certain circumstances. The thinner 
chipboard will cut easily in one to three passes with 
a knife, but the thicker chipboards may take many 
passes to cut through cleanly.

Museum Board/Matboard
Museum board and matboard are similar to white 
chipboard but will have a very particular surface 
finish and can often be found in a variety of colors 
on one side. These materials can make very nice 
models and are designed to be used for art framing. 
Be aware that the acid-free archival quality sheets 
can cost several times more than chipboard.

Butterboard/Pulpboard
Butterboard is generally lighter and less dense than 
chipboard and is very easy to cut and bend into 
curves. It is usually a cream or off-white color, and 
models made in butterboard will tend to yellow 
quickly in storage for long periods. Pulpboard is 
similar in appearance but may have some color 
variation and a more textured surface.

Corrugated Cardboard
Corrugated cardboard can be salvaged from ship-
ping boxes or purchased in large clean sheets. It 
is good for building thickness quickly and is quite 
rigid due to the corrugated interlayer. Care should 
be taken to cut it cleanly, and it has a very distinc-
tive appearance, so should only be used in specific 
circumstances.

Chipboard.

Museum board.

Butterboard.

Corrugated cardboard.
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Foam Core
Like corrugated cardboard, foam core is thick and 
rigid, and is usually found in white or black. It's 
surface will often have a slightly shiny satin finish, 
which will appear differently than the more matte 
finish of paper or chipboard. Care needs to be taken 
to cut it in a way that the inner foam layer does 
not tear (use a very sharp blade and several lighter 
scoring passes with a knife). Foam core has a very 
distinctive appearance, and many have strong 
opinions against using it, so it should be used only 
under specific circumstances. Another version, 
Gator board, has plastic faces and is extremely 
rigid, but also much more difficult to cut.

Basswood
Basswood can be found in sticks, sheets, and blocks 
in various dimensions for use architectural models. 
Sheets and sticks around 1/16" or thinner can be 
cut easily with a knife. Pieces up to 1/8" can be cut 
slowly by hand, but will require more cuts with a 
knife. Basswood sheets can be cut just like other 
sheet materials, but will cut more easily parallel to 
the grain and will require a few extra cuts across 
the grain. It can be easily sanded and attached with 
wood glue. Basswood is recommended over balsa 
wood, which is softer, more fragile, and often has 
distracting grain.

Solid Materials
Wood and foam are the most common solid 
modeling materials. There are many other material 
options that fall into this category, but often require 
specific tools or techniques.

Wood
Wood is an extremely versatile material that can be 
transformed in numerous ways with specific tools. 
Wood from different tree species can be drastically 
different in appearance, density, and other 

Basswood.

Foam core.

qualities. It is possible to carve or shape smaller 
pieces of softer woods at a desk, but wood is best 
manipulated with designated woodworking tools in 
the woodshop.

Cast Materials
A variety of cast materials can be formed into 
molds through either heat or chemical or processes. 
Always follow manufacturer's safety instructions 
when casting.

Rockite & Plaster
Rockite and plaster are purchased as powders 
that become very hard and solid when mixed with 
water and cast. They can pick up very fine details 
from molds. Rockite is gray and looks like concrete 
without stone aggregate. Plaster is white or off-
white. Both can be tinted with ink or pigment or 
combined with sand, stones, or other aggregates.

Wax & Glycerin
Wax and glycerin are solid at room temperature 
and are formed by heating until liquid and pouring 
into a mold. Both are relatively soft and can be 
carved by hand. Translucent options are available 
for both, producing interesting visual effects. Both 
can be tinted to various colors with ink or pigment.

Plastics & Resin
Many types of plastics, resins, and rubbers 
are available, and are cast by mixing specific 
proportions of two different liquids. These are 
usually expensive and produce fumes, so are only 
recommended for very specific applications.

Tools
Investing in quality tools that will work reliably over 
time will improve both quality and efficiency in 
model making.

Rockite.
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X-Acto
The X-Acto precision knife is a very versatile tool 
that can be used for everything from large straight 
cuts to curves, to very small and intricate detail 
work. Because of its size, it is held like a pencil for 
very fine control. Different blades are available for 
different applications, but the standard #11 blade 
will work well in most cases. Since the point is very 
sharp and tapered, be aware that the tip can break 
off if you are cutting with a lot of pressure. Keep 
extra blades on hand to replace dull blades fre-
quently. Use a safety sharps container or wrap the 
blade in tape before disposing.

Olfa
Olfa is the most common brand of snap-off utility 
blades. They are very useful for long, straight cuts 
through thicker or tougher materials. The handle 
is thicker than an X-Acto, meaning it is easier to 
cut with more pressure. They come in smaller and 
larger sizes, and the larger size is recommended to 
better complement the use of your X-Acto. Blades 
can be incrementally snapped off when they become 
dull by carefully extending one segment of blade 
past the metal end of the knife, locking it in place 
by tightening the thumb screw, holding the exposed 
blade segment under the edge of your cutting mat, 
straightedge, or thick sheet material, and angling 
up with the handle of the knife.

Straightedge
A good metal straightedge/ruler is critical for model 
making. A cork or foam backing strip will help to 
make sure that the tool does not slip when cutting – 
make sure the non-slip side is down! Your straight-
edge can also be used to measure and mark longer 
dimensions before cutting. DO NOT use your plastic 
drafting tools (scale, triangles, French curves, etc.) 
as an edge for cutting – this will cut into the edges 
of the tools, making them unusable for drafting.

Metal straightedge/ruler.

Snapping off a blade 
segment.

Olfa knife.

X-Acto knife.

Architect’s Scale
An architect's scale is very handy for measuring in 
inches, but also in measuring dimensions at several 
model scales, so that you can think in real-world di-
mensions while building a scale model. The differ-
ent faces of the tool allow measurement at different 
architect's scales, so make sure you are using the 
correct side!

Miniature L-square/Triangle
Also available as a miniature triangle, this metal 
tool is very useful for measuring small lengths 
and to use as a straightedge when cutting intricate 
details. It does not have a non-slip backing, so use 
caution it does not slide when cutting against it. It is 
also very helpful to use as a guide to ensure surfac-
es are perpendicular when gluing.

Cutting Mat
All cutting should always be done on a cutting mat, 
for safety and to protect your other work surface. 
Cutting mats are designed with layers of plastic 
and rubber to ensure you can cut into them but not 
through them, and so that they will not be destroyed 
even after years of cutting (this is why some are 
marketed as “self-healing”). DO NOT ever cut di-
rectly on your drafting board or other surface used 
for drawing including your desk, as the cut marks 
will ruin the surface. 

Clamps
Clamps come in a variety of types, shapes, and 
sizes, from small spring clamps to long bar clamps. 
They are useful for holding materials tightly to-
gether when gluing. Make sure your clamps do not 
indent or mark paper products or wood materials – 
avoid over-tighten and make sure they have rubber 
surfaces where they attach to your material (a few 
layers of paper towel can also to cushion as well).

Clamps.

Cutting mat.

Architect's scale.

Miniature L-square.
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123 Blocks
123 Blocks are made of steel, often with threaded 
holes, measuring exactly 1 inch by 2 inches by 3 
inches. They are a versatile tool due to their exact 
dimensions, perpendicular faces, and weight that 
makes them very stable. Use them for position-
ing and weighing down pieces during gluing and 
assembly. A block on either side of a vertical sheet 
of material will make it easy to glue precise perpen-
dicular intersections.

Consumables

White glue
Sobo and Elmer’s are popular brands. White glue is 
versatile and dries relatively clear. It will be slightly 
rubbery when dry.

Wood glue
Titebond is a popular brand. Wood glue is usually 
very yellow in color, so care should be taken not 
to use more than necessary. It is better for model-
ing with basswood than paper products but dries 
harder and more rigid than white glue, which is 
useful in some cases. Wood glue works best when 
glued with some pressure between surfaces (clamps 
or weights).

Superglue
Loctite and Zap are popular brands. Superglue 
comes in a variety of formulas and viscosities, from 
liquids to gels. It dries strong but sometimes brittle, 
and some formulas harden quicker than other 
adhesives. Many superglues will soak into paper 
products and produce unsightly stained areas, so 
are generally not recommended for use with paper 
products. Superglue will glue your fingers together, 
so use extra care to not get any on your skin or near 
your face.

White glue.

123 blocks.

Wood glue.

Superglue.

Gorilla glue
Gorilla glue is a specific formula that is designed 
to expand to fill gaps. Any exposed glue will appear 
bubbly or foamy when dry. It is recommended only 
for specific applications.

Tape
Tape is not recommended for model construction, 
as it is usually very visually distracting in your com-
pleted model. Lighter adhesive masking tapes such 
as painter’s tape are sometimes useful for holding 
corners tightly together when gluing, but are re-
moved after the glue is dry, making sure to not tear 
or rip the surface of the material.

Sandpaper
Sandpaper provides an abrasive surface to file or 
sand down certain materials. All sandpaper has a 
number representing its grit or coarseness. Lower 
grits (60, 80, 100) are coarser, while higher grits 
(220, 320, 400) are finer. If smoothing a surface, 
sand first with a coarser grit and then a finer one. 
Sandpaper can be used by hand, or taped to a 
smooth block of material to make a sanding block. 
To smooth edges of basswood or chipboard, place a 
sheet of sandpaper on a smooth clean surface, and 
drag the edge of your material across it.

Gorilla glue.

Sandpaper.
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Techniques: Sheet Materials

Measuring
Except for quick and messy study models, it is usu-
ally necessary to accurately measure pieces to cut 
throughout your model making process. Drawing 
guidelines on your material is often a great strategy 
– use a sharp pencil so your marks are very accu-
rate. You can use your straightedge ruler, scale, and 
triangles to measure and mark lines, but remember 
to only cut against your metal straightedge.

Cutting
Take extra care when cutting to make sure that your 
cuts are precise and clean, and to ensure you do 
not injure yourself. Here are some things to keep in 
mind:

1.	 Make sure your blade is very sharp. A dull blade 
will produce less precise cuts and require you 
to use more pressure when cutting, meaning 
you are more likely to slip and injure yourself.

2.	 Cut against your metal straightedge whenever 
possible. Make sure the non-slip side of the 
straightedge is down, and that your fingers 
holding down the tool are well away from the 
edge and out of the line of the cut.

Cutting with a straightedge 
– keep fingers away from 
line of cut.

Cutting small details with 
a miniature L-square or 
triangle.

 
3.	 Keep your blade perpendicular to the surface 

being cut. This will ensure that your cuts are 
cleaner and more precise, and that the edge 
of the material you cut is straight for ease of 
gluing.

4.	 It is better to make several lighter passes to cut 
through a material, rather than use too much 
pressure to try to cut through in one go. Some 
very thin materials can be cut in one pass, but 
most will require multiple lighter cuts. Make 
sure your straightedge does not slide or move 
between passes with your blade.

5.	 Curved cuts can be done freehand with an 
X-Acto. Make sure the material you are cutting 
is held down so it does not slip, and follow th 
above advice regarding multiple lighter passes 
and perpendicular blade position.
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Cutting a curve.

Scoring and folding for a 
sharp edge.

Scoring and Folding
Scoring is an effective strategy for making very 
precise and crisp folds in your material. This is 
particularly true of Bristol paper, and some thin-
ner chipboard, although it becomes less effective 
the thicker the material. To make a score, measure 
your line and use your metal straightedge as if you 
were going to cut the material, but make only a light 
pass across the material with your knife, using even 
pressure across the length of the score. This should 
cut only part of the way through the material. If 
you cut too deep, the material will split apart when 
folded, and if you cut too lightly, it will be difficult 
to fold along the line. It is better to start lighter, as 
you can always make another light scoring pass if 
needed (just be very careful to align your straight-
edge precisely over the same line).

Gluing
White glue is the most common adhesive for as-
sembling models in paper and chipboard. There are 
a few things to keep in mind when gluing:

Applying glue to an edge.

1.	 Amount – Use enough glue to cover a thin layer 
on the surface, but not so much that it drips 
everywhere when the pieces are pressed togeth-
er. If any oozing does occur, you can use a scrap 
strip of paper to carefully wipe it off.

2.	 Application – In some instances, you will want 
to apply glue directly from the bottle to the 
surface (do this with superglue). In most cases 
(particularly when applying glue to thin edges 
of material) you will want to apply glue differ-
ently. On a scrap piece of material, deposit a 
small amount of glue (around the size of a coin). 
Touch this glue with your finger so that a drop 
adheres to your fingertip. Transfer this glue to 
the edge of the material by sliding and gently 
rolling your finger down the length of the ma-
terial in a smooth, continuous motion. Beware 
of paper cuts – pressure is not needed. You 
can also use a strip of scrap Bristol paper or 
chipboard to apply the glue. If joining material 
in a T shaped connection, always apply glue to 
the thin edge of the material, not a line in the 
middle of a flat face.
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Positioning with 123 blocks.

3.	 Positioning – Once glue is applied, gently press 
your materials together, avoiding sliding and 
shifting them around, as this will spread glue 
farther away from the joint. Use 123 blocks, 
clamps, or other weights to hold objects in posi-
tion while the glue dries whenever possible.

4.	 Visible sides – Sometimes your model will have 
interior surfaces and volumes that will not be 
visible in the completed model. In these cases, 
be mindful of which edges will show more than 
others, and try to keep any tabs or messy glue 
joints hidden as much as possible.

5.	 Laminating – To laminate two surfaces face-
to-face, apply a modest line of glue around the 
perimeter of the surface, and use a small scrap 
of rigid paper or thin chipboard to spread the 
glue evenly across one of the two surfaces. 
Try to cover the surface as evenly as possible, 
and avoid large amounts of glue built up in 
concentrated areas. Use the paper spreader 
to make sure glue reaches to all edges, which 
will prevent the edges from delaminating once 
glued. Once glue is applied, properly position 
the pieces, press them gently together, and use 
123 blocks or other flat heavy objects to keep the 
surfaces pressed while the glue dries. If a lot of 
glue oozes out along the edges, apply a thinner 
layer of glue in the future. 

Laminating – spreading 
glue and weighing down.

Pre-bent curved surface 
before gluing.

Curves
Bristol paper, some thinner chipboards, and but-
terboard can usually be bent into smooth curves 
without producing excessive creasing. This is most 
effectively accomplished by gluing against anoth-
er surface that has been cut to the desired shape. 
When gluing curved surfaces, it is both more 
difficult and more critical to make sure the material 
is held tightly together and does not spring back 
toward flat while gluing. You can use the same po-
sitioning tools to do this including using a small tab 
of tape, but you may have to be a bit creative in how 
this is accomplished. It is also helpful to pre-roll or 
bend your material to the approximate curve you 
want using your hands before trying to glue it in 
this position. See directions in “Cutting” above for 
producing clean curved cuts.
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Techniques: Casting

Mold Preparation
The most critical and time consuming part of 
casting is the creation of a reliable mold. The mold 
is a vessel into which you will pour a liquid casting 
material. The mold will determine the form and 
texture of the final cast model.

When designing a mold, you can think about it as 
an inversion of the solids and voids in your model 
(or a boolean difference operation in Rhino). If you 
have a rectangular block of solid material inside 
your mold, this will become a rectangular void once 
the model is cast and the mold is removed. Gener-
ally, molds are single use and will be destroyed to 
reveal the cast model, with a few exceptions includ-
ing reusable silicone molds.

Below are some guidelines for mold preparation:

1.	 Consider building your mold such that your 
model is cast upside down. The top surface of 
the poured casting material will be the least 
refined surface once cast, so it is usually best 
to plan for this to become the bottom of your 
finished model.

Building mold using glue to 
secure edges.

Mold pieces.

2.	 Molds must be watertight. The best way to 
avoid leaks in your mold is to cover all seams 
with a bead of hot glue on the outside of the 
mold. It is helpful to build the mold a bit taller 
than needed with a fill line drawn around the 
top.

3.	 Gravity will limit some possible forms. You will 
be pouring a liquid into your mold, and con-
cealed complex geometries that wrap up and 
down may prevent your casting material from 
flowing into all parts of the mold. This may 
mean casting your model in another orientation 
or casting it as multiple parts.

4.	 Be careful with very small details or thin linear 
or planar elements, which will be very fragile. 
For larger planar surfaces, around 1/4” is a 
good minimum thickness.

5.	 The inside of your mold is the important side. 
Glue oozing out of the mold will not affect the 
cast, but glue oozing on the inside of the mold 
will be legible in the completed cast.

6.	 Mold materials - molds can be made with a 
variety of materials to varied effects. You are 
encouraged to experiment with different mold 
materials with two considerations in mind:

	 a.	 Cast materials will take on the texture of 
your mold, meaning that your mold materials 
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       will have a large effect on the appearance of 
your cast model. Materials such as chipboard 
will give a matte finish to the cast, while acrylic 
or other smooth plastics will make the cast 
material appear glossy and polished. Wood 
will often convey the texture of its grain to the 
cast material, while styrofoam will create the 
impression of the foam bubbles which make up 
its surface. Other materials such as fabric and 
tin foil will lend unique textures to your cast 
model.

	 b.	 Mold materials will need to stand up to 
water and pressure. Porous and absorbent 
materials such as chipboard, cardboard, and 
foam-core can usually withstand the moisture 
of the cast for long enough to serve as produc-
tive mold materials. If you are making a very 
large mold that will hold a lot of cast material 
or have large flat surfaces, the mold materials 
will need to withstand the pressure of the liquid 
cast material, which can be quite heavy. Large 
flat surfaces in particular are at risk of bowing 
outward under pressure, which can be mini-
mized by using a more rigid mold material or 
by reinforcing the surface with some perpen-
dicular reinforcing strips on the outside of the 
mold.

Workspace Preparation
Once your mold is prepared, you will need to 
prepare a workspace for casting. You will need the 
following:

-	 Large tray or plastic drop-cloth (to help contain 
material in the event of a leak or spill).

-	 Completed mold.
-	 Casting material (rockite or plaster powder).
-	 Water (a bottle or cup of clean tap water).
-	 Mixing stick (a wood strip or other implement).

Casting supplies.

-	 Emergency leak repair (a hot glue gun is ideal, 
but a roll of masking tape can also help to patch 
minor leaks).

Mixing
Once your workspace is ready and your materials 
are on hand, you can proceed with mixing your 
rockite or plaster (instructions will be given for 
rockite here and a few differences for plaster are 
noted):

1.	 In a clean plastic cup or bucket, mix together a 
small quantity of rockite and water. Mix these 
together with your mixing stick, making sure 
that there are no lumps or dry patches at the 
bottom. When mixing plaster, it is advisable to 
sift the powder into the water and let it soak for 
a minute or two before mixing. Always refer-
ence any specific mixing instructions on the 
product you are using.

2.	 Your rockite mixture should be about the con-
sistency of pancake batter. It should be thicker 
than water but not as thick as honey. When 
poured into a container, the top should be flat 
and level and not create a mound.

3.	 Continue alternating between adding rockite 
and water and mixing until you have enough 
rockite mixed. Add water conservatively, as too 

Mixing workspace.
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Consistency should be sim-
ilar to pancake batter, no 
thicker than pictured here.

       much water will require a lot more rockite to 
balance the mixture.

4.	 Try to mix a little bit more material than 
needed to fill your mold, as mixing two little 
and having to do a second pour will produce a 
visible line in the cast.

Pouring
Once your mix is ready proceed with pouring into 
the mold:

1.	 For an even cast, pour slowly and consistently 
into a single point in the mold, letting the liquid 
spread out across surfaces to fill the volume.

2.	 Once your mold is full, vibrating the mold will 
help to settle the material and work trapped 
air bubbles to the surface. This can be accom-
plished by tapping repetitively on the side of 
your mold for a minute, or, in durable molds, 
by pressing the top of an orbital sander or other 
vibrating tool against the side of the mold.

Removing the Mold
Timing for removing the mold is critical so that 
your mold does not adhere to your cast. If you need 
to leave your mold unattended after casting, you 
will need to use a mold release agent such as Vase-
line to coat the interior of the mold and ensure you 
can remove your cast. This will usually effect the 
texture of your cast, so the alternative is below:

Pour slowly and consis-
tently in a single location. 
For complex molds, rockite 
can be mixed slightly thin-
ner than pictured here.

Curing Rockite.

Removing the mold.

1.	 After pouring, let your mold sit until you can 
rub a fingertip across the exposed cast surface 
without rubbing any material off. Then, wait 
an extra minute or two for good measure. With 
rockite, this usually takes about 10-15 minutes 
after pouring.

2.	 At this point your cast will be solid but still 
warm and damp. Begin carefully removing the 
mold from your cast, taking care not to apply 
pressure to sharp corners or small parts, which 
are at risk of breaking.

3.	 Once your mold is removed, any mold material 
that has adhered to the cast (for example, 



Production Manual  |  9998  |  University of Virginia School of Architecture

Completed cast (note rip-
pled face due to moisture 
warping face of corrugated 
cardboard mold).

	 paper pulp from chipboard) can be removed 
by rubbing with a fingertip or eraser. It is best 
to do this immediately, as the longer you wait 
the dryer and more adhered the material will 
become.

4.	 Your cast is complete! Admire and share your 
hard work.
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Digital Modeling:  Tools & Materials
In a simple, conceptual sense, 3D digital modeling 
is a process of translating 2D geometry (points, and 
lines) into surfaces and volumes. One way to think 
about this process is to consider the materials,
assemblies, and part-to-whole relationships of your 
projects. Conceptualizing the process should be 
critical toward the modeling strategy itself. Deci-
sions about which parts of the modeling process
employ additive or subtractive techniques should be 
tied to a larger set of questions that explore the con-
struction logic, organization of the plan and section, 
programmatic use and functionality, and spatial
sequences of a project. 

Why Rhino?
There are a number of different 3D modeling 
softwares available to you and many of them share 
commands and workflows for generating and 
manipulating 3D surfaces and solids.  This manual 
focuses on 3D digital modeling in Rhino as it is 
widely used by students and practicing designers 
for studying and developing designs in 3D. 

We've touched on Rhino's 2D capabilities, but it is 
most well known for it's 3D modeling tools.  This 
section builds on the previous Rhino section, fo-

cusing on the 3D modeling tools and best practices.  
Please review the section on digital drafting tools 
and techniques for information regarding file navi-
gation, layer settings, object properties, and more.  

Operating System
The examples presented here are shown in Rhinoc-
eros 7 or 8 for Windows. Rhino is also available for 
macOS, and is very comparable in performance to 
the Windows version. The interface and location of 
some commands and settings will be different on 
macOS Rhino, but the concepts are all the same. It 
is recommended that you use Rhino for Windows, 
for ease of use working between programs, many of 
which were developed primarily for Windows.

Commands
Many of the commands covered in this section 
describe common ways in which 2D geometry can 
be used to generate a 3D surface or solid volume in 
Rhino.  This is by no means an exhaustive list as 
there are multiple methods for achieving this trans-
lation, but it covers the most common commands 
for working fluidly with points, lines, surfaces, and 
polysurface solids. 

The Help menu, located adjacent to the Properties 
and Layers menus, is useful to keep open when you 
first start working in Rhino. When you initiate a 
command, it outlines the steps required to perform 
the action and describes each option within the sub-
menu with illustrations and detailed steps.

Mouse
Like several other design programs, a comput-
er mouse is absolutely necessary to properly use 
Rhino. The program will function without one, but 
navigating a 3D model will prove especially difficult 
and time intensive. Just use a mouse.
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Modeling Commands

Generating a Surface 
from Linework	
	
PlanarSrf (PS)
ExtrudeCrv (EC)
Loft
Patch
Sweep1
Revolve

Generating a Poly-
surface Solid from a 
Surface

CreateSolid (CS)

ExtrudeSrf (ES)
OffestSrf (OS)

Inset

Modifying a Surface 
or Polysurface Solid

Scale (S)
Scale1D (S1)
Move (M)
MoveEdge (ME)
MoveFace (MF)
Copy (C)
Trim (TR)
Rotate (RO)
Rotate3D
Mirror (MI)
Boolean2Objects

(Possible Aliases or shortcuts in parentheses)

Generates a planar surface from planar curves
Extrudes a curve into a surface (or solid)
Lofts disconnected lines together into a surface
Creates a surface from complex curves or points
Lofts perpendicular lines into a surface
Revolves a line about a radius to create a surface or 
solid

Creates a closed polysurface from individual sur-
faces
Extrudes a surface into a solid
Offsets a surface from original destination a speci-
fied distance
Insets a surface from original location a specified 
distance (New in Rhino 8)

Scales in 3 dimensions
Scales in one dimension
Moves any object
Moves an edge of a solid
Moves a face of a solid
Copies any object
Trims intersecting objects
Rotates an object on xy plane
Rotates an object in z plane
Mirrors an object about an axis
Cycles through Boolean operations (Difference, 
Intersection, Split)

Closes open polysurfaces with a planar surface
Arrays an object in x, y, and/or z axis
Explodes an object into its parts
Joins objects that are touching
Groups objects to be selected together
Ungroups objects that are grouped
Hides objects from view
Shows hidden objects

Extracts a boundary curve of a surface or polysur-
face
Extracts a curve from selected surface or polysur-
face
Extracts surface isocurves as separate curves
Extracts a planar curve or points at the intersection 
of a defined cut line and an object within Rhino
Creates a series of sequential planar curves at 
points of intersection through a surface or solid
Plane that clips away geometry in specified view-
ports
A series of clipping planes through selected objects
Extracts sections and background geometry of Clip-
ping Planes and projects the linework to a defined 
plane - typically the World Top plane
Extracts selected object edges and outlines in a 
specified view and projects them to a defined plane 
- typically the World Top plane

Reverts back to previous camera view
Widens the view to include all objects within the file
Allows you to show certain hidden objects rather 
than all
Allows you to save a specific view and return to it

Cap
Array
Explode (EX)
Join (J)
Group
Ungroup
Hide
Show

Extracting 2D from 
3D

DupFaceBorder (DF)

DupEdge (DE)

ExtractIsocurve
Section

Contour

ClippingPlane (CP)

ClippingSections
ClippingDrawings

Make2D

Additional Modeling 
Aids

UndoViewChange
ZoomExtents (ZE)
ShowSelectedOb-
jects
NamedView (NV)
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Command Prompt

Object Snaps

Toolbars

Toolbars

Default Top Viewport

Default Front Viewport

Rhinoceros workspace.

Properties & Layers

Default Perspective Viewport

Default Right Viewport

Rhino World 
Coordinate System

Viewport Options

Other Snaps
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Viewport options drop-
down menu.

Workspace

Viewports
The Rhino workspace by default consists of four 
viewports: Top, Perspective, Front, and Right. 
Any modeling work can be done in any of the four 
viewports, and you can switch between viewports 
mid-command. This can be helpful to move things 
in certain directions in a very controlled way. 
Left-clicking on the name of a viewport in the upper 
left corner will yield a variety of options.

Double-clicking on the name of a viewport in the 
upper left corner will toggle between the four 
viewport layout and a single, full window viewport. 
This can also be changed via tabs at the bottom of 
the Rhino workspace. The view in each viewport is 
completely customizable, including isometric views 
which can be found in the viewport options drop-
down menu under Set View>Isometric.

When working on a 3D model, you may find it 
helpful to work primarily in the Perspective view-
port, but you continue to use the other orthographic 
views to precisely snap to certain elements. In this 
case, you can make the Perspective viewport larger 
than the others by clicking and dragging the inter-
section of the viewport windows.

Display Modes
When building a digital model, display modes not 
only affect the precision with which a model is 
constructed but also the way in which it is perceived 
and understood. Rhino’s default display modes offer 
a range of visibility options and lighting effects. 

New display modes can be created or existing 
modes can be modified to facilitate and focus
the reading of the model. Your most commonly 
used viewports will likely by Shaded, Ghosted, Ren-
dered, Monochrome, or Arctic.

Linkedin Learning:
Display Modes

The default display modes for a view can be ad-
justed by clicking on the drop down menu of any 
view. Default options include Wireframe, Shaded, 
Rendered, Ghosted, X-Ray, Technical, Artistic, Pen, 
Monochrome, Arctic and Raytraced. Certain modes 
use less processing power, allowing you to model 
efficiently. 

Wireframe is the lightest, but Shaded, X-Ray
and Ghosted also work well. It is not recommend-
ed to use the other display modes while actively 
modeling as they render in real-time and tend to 
slow down your computer or obscure line, surface 
or solid snaps, edges and extents. The SetObjectDis-
playMode command can be used to change a specific 
object’s display mode within the view
while maintaining the display mode of the view 
itself.

To create a custom Display Mode or to modify 
an existing mode, navigate to Rhino Op-
tions>View>DisplayModes in Document Properties.  
Here you can select a certain display mode (such 
as Shaded or Ghosted) and fine tune the display 
settings.  If you select an existing mode, create a 
copy, rename it, and adjust the viewport, shading, 
visibility and lighting settings as needed. 

Under Objects>Surfaces>Edge Surface Settings, 
reducing the edge thickness (pixels) to 1 will display 
the edges of objects in a much finer lineweight, and 
make the linework of your models less distracting.

Linkedin Learning:
Viewport Navigation

Wireframe Shaded RenderedGhosted

Display Modes

Linkedin Learning:
Exploring Viewport 
Features
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In the same DisplayMode settings, you can disable 
“Show Isocurves,” which will eliminate visualization 
of lines dividing surfaces in your model. These can 
be helpful when modeling surfaces with complex 
geometries, but are usually distracting when work-
ing with planar surfaces.

Changes made to DisplayMode settings will only 
have an effect on the selected display mode, so if 
you want certain characteristics to carry over to 
other views, you will need to change these settings 
on all the display modes you choose to use.

Model Navigation
Your model can be navigated using commands, but 
it is best to learn to do this quickly with your mouse 
and a few keyboard shortcuts:

Perspective & Parallel viewports:
	 Orbit - right-click+drag
	 Pan - Shift+right-click+drag
	 Zoom - mouse wheel
		  or Ctrl+right-click+drag

Linkedin Learning:
Setting and Fixing Rhino 
Preferences

Document Properties>
View>
DisplayModes>
Objects

Orbit will rotate the view around a fixed point in 
space. To reset this point on a specific object, use 
the Zoom window or Zoom Selected button (alterna-
tively, select an object and use the ZS command).

Selecting Objects
Objects in your model can be selected by left-click-
ing on them in any viewport. If objects are closely 
overlapping, Rhino will sometimes provide a small 
drop-down menu for you to select which object to 
select. To deselect objects, press down the Ctrl key 
while left-clicking on the object you'd like to remove 
from the selection.  If objects are grouped or part of 
a polysurface or polyline, one click will result in a 
selection as opposed to clicking on individual items. 

Left-click+drag is used to select multiple objects. 
Dragging to the right will produce a selection box 
with a solid line edge, and only objects entirely 
inside the selection box will be selected. Dragging to 
the left will produce a selection box with a dashed 
line edge, which will also include any objects par-
tially inside the selection box.

Snaps
Along the bottom of the Rhino workspace, you will 
find a toolbar with several snapping options.  The 
previous Rhino section covers snaps related to 
drafting within Rhino.  The ones listed here are 
additional snap options and settings primarily for 
modeling in 3D. 

When building models in Rhino, it is often critical 
to be very precise in how objects are connected to 
one another. Several editing commands used to ma-
nipulate objects will not work properly if objects are 
not connected or intersecting properly. Problems 
like this usually arise from not using the correct 
snaps – it may look like two lines are perfectly 

Left-click+drag to left = 
include objects partially 
inside selection box.

Left-click+drag to right = 
select objects entirely 
inside selection box.

Zoom window, zoom 
extents, and zoom selected 
toolbar buttons.

Linkedin Learning:
Selecting Objects
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connected to form a corner, but if you zoom in very 
close, you may realize that they are actually separat-
ed by a very small amount. Proper use of snaps will 
help to avoid these frustrations.

Planar
Planar snap is a tool that allows you to select a point 
at the beginning of a command, and automatically 
projects all other points to the same working plane 
as the first point. For example, if you wanted to 
trace the plan of a cantilever on the ground plane, 
you could use a combination of Planar snap and 
Object snap to achieve this.  This setting is partic-
ularly helpful when 2D and 3D information exist 
within the same file. 

Osnap
Osnap is short for Object Snap, an incredibly useful 
tool that will insure you are connecting objects pre-
cisely with zero tolerance. There are several Osnap 
options that can be individually enabled/disabled.  
A few of the snaps listed here are also listed in the 
previous Rhino section.  They are included here to 
reiterate their significance in the modeling process: 

End – endpoint
Near – nearest line/edge
Mid – midpoint
Cen – center of curve/surface
Int – intersection
Perp – point of perpendicular intersection
Tan – tangent point
Quad – quadrant point (maximum x/y coordinates) 

of circle or ellipse
Knot – knot point
Vertex – mesh vertex point
Project – this option projects the point you are 

snapping to onto the Rhino construction plane 
(xy plane by default)

Gumball
Gumball can be toggled on or off and is a tool that 
will appear in the Rhino viewports whenever an 
object is selected. It can be used to quickly move, 
rotate, or scale an object along the x, y, or z-axis, or 
to move an object around on the xy, yz, or xz plane. 
Use of the Gumball tool is a matter of personal 
preference – some find it fast and convenient, while 
others find themselves moving objects by mistake 
and prefer the precision of using move, rotate, and 
scale commands manually. Feel free to turn it on 
and off on the fly using the Gumball button in the 
snaps toolbar.

Layers

Layers are critical for keeping your files clean 
and organized so that you can model efficiently 
and make edits to large parts of your model in a 
quick and controlled way. There are many possi-
ble strategies for organizing your layers including 
by iteration, floor level, element, material type, or 
lineweight. It is recommended to experiment with 
a few strategies until you find the best method for 
you. Be aware of how long it is taking you to assign 
objects and make changes using layers – many 
basic operations can be repeated hundreds of times 
while building a complex model, so taking the time 
to reflect and improve your layer management 
strategy can save you substantial amounts of time 
when modeling.

A common strategy to try when starting out is to 
create layers for different categories of objects, 
which may vary depending on what you are mod-
eling: frames, planes, and volumes for an abstract 
model; floors, walls, ceilings, and columns for a 
building; topography, streets, and buildings for an 
urban model; etc.

Gumball tool.
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You can duplicate all of these objects as sublayers 
under layers for separate iterations, but your layers 
menu will become cluttered quickly. Another strat-
egy for handling iterations is to construct a series 
of models in a row in Rhino (usually along the x- or 
y-axis), separated by a set distance so that it is quick 
and easy to move/copy objects between iterations 
and know they are located accurately.
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Workflows

Objects of design and architecture are often 
presented as the result of a clear operative process, 
making the journey of arriving at a design seem like 
a single path, where the final result was clear from 
the beginning, but in reality, the processes of design 
are far from linear. 

Design is extremely iterative. 

Iteration is a repeated process of thinking through 
making — in models and drawings — to develop, 
test, critique, and improve ideas. It requires risk 
taking  and trial-and-error to arrive at the best 
possible design.

An iterative process can help you test, refine, 
and detail your ideas, and to discover new or 
unexpected possibilities. It is most productive to 
work iteratively in series, modeling or drawing 
multiple ideas quickly before stepping back to 
analyze, evaluate, and critique your designs either 
independently or with others.

Thinking through multiple, often different, 
solutions to a design problem helps determine 
what considerations take priority in developing 
the argument for your design solutions. This 

may involve testing several drastically different 
approaches to a design prompt before selecting 
a scheme or strategy to develop through further, 
focused iteration. 

Working Across Media
Iteration often demands working across media and 
scales, through models and drawings, 2D and 3D, 
and analog and digital methods. The more adept 
you are at moving between different media, the 
quicker and farther your designs can progress. 
There are many methods for moving between 
design programs and between analog and digital 
production.

This section of the Production Manual presents a 
series of important workflows to help you move 
between various media and modes of production.
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3D Modeling Workflows: Digital + Physical

Physical to Digital
When modeling by hand, it is important to work 
at a consistent scale for the ease of translation into 
digital drawing or model.  To translate a physical 
model into digital model, measure directly from 
your physical model, and rebuild the model ele-
ments digitally at full scale. Scaled imported images 
of the top and sides of the model can also assist in 
its digital construction.  Refer to the previous Rhino 
sections for information regarding file setup and 
best practices. 

Digital to Physical
Often, you will need to produce quick physical 
models to test ideas that you have been drawing or 
modeling digitally. There will be times when you 
can 3D print or laser cut such models, but some-
times it can be faster or more productive to make 
these models by hand.

This can be done productively in a number of ways 
by printing drawings and using them a paper tem-
plates to cut your modeling material, such as bristol 
paper, chipboard, or foam. Another quick way of 
incorporating drawings into your models is to use 
an acetone transfer technique. 

Acetone Transfer
Acetone is the main ingredient in many nail polish 
removers and can be found in the paint section 
of a hardware store. It can be used to transfer ink 
and give the illusion of a drawing or image having 
been printed directly on a variety of materials. It is 
a quick way of getting accurate dimensions and ge-
ometries onto a surface to then cut, fold, or glue to. 
A common technique is to transfer a plan drawing 
onto a sheet of material, cut along the lines to create 
floor plates, and glue vertical walls where walls are 
seen in the plan.
To acetone transfer a drawing:

1.	 Print a mirrored version of your drawing on 
a laser printer. The type of printer and ink 
matter. Drawings from a typical plotter will not 
work.

2.	 Prepare your material to transfer onto. Chip-
board, museum board, basswood, Rockite, 
and plaster surfaces will all receive an acetone 
transfer well. Overly glossy surfaces such as 
shiny plastics usually will not work (although 
frosted or sanded plastic will).

3.	 Flip your printed drawing upside down and 
carefully position it on your model material. 
The printed side of the paper will be pressed 
against your model. Tape a few edges of the 
print down so that it is held in place.

4.	 Using a cotton ball, paper towel, or rag, apply 
a small amount of acetone to the back of the 
paper. It will quickly become saturated so you 
can see the image through the paper.

5.	 Using the back of a spoon or other smooth hard 
object, apply pressure and rub the paper against 
your model material. Rub the entire area of the 
drawing and make sure that the paper does not 
shift.

6.	 Remove and discard the paper. The ink from 
your printed drawing should now be attached 
to your model material.

Acetone is a chemical that gives off fumes. Use it in 
a well ventilated space and wear gloves if you are 
will be doing a lot of acetone transferring.
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Importing: From 2D to 3D

Analog Drawing to Rhinoceros
Sometimes you may want to scan a sketch or analog 
drawing and then draw over it in AutoCAD or 
Rhino. This workflow is also effective for bringing 
satellite imagery into AutoCAD to trace elements for 
site plans or to study precedent projects by import-
ing original drawings for analysis. You can easily 
bring scanned drawings or other image files into 
Rhinoceros. To keep scaling as accurate as possible, 
include a scale bar on your drawings or know the 
exact dimension of a specific element in your draw-
ings, such as a door or stair width. 

Open Reference Files in Rhinoceros
You can bring .jpeg, .png, and other image files 
into your Rhinoceros file. To do so you can simply 
drag the saved image file from the finder window 
into your .3dm file.  Once you drag it in, you will 
be prompted by an 'Image Options' menu.  Specify 
'Picture' and click 'OK.'  Click into Top view and 
specify the image extents. 

You can also bring in image files using the Picture 
command: 
1.	 Type the Picture command and press Enter.

Image Options Prompt.

2.	 Click once in your Rhino file to choose where 
to place your image, and again to determine its 
size, which can be adjusted later. Your image 
will now be an object in your Rhino file.

Scaling
You can use the Scale command to accurately size 
your image based on a particular line, shape, or 
other object length in the image:
1.	 Type the Scale command and press Enter.
2.	 Select your image to scale and press Enter.
3.	 For 'Base point,' click one end of the reference 

length in your image.
4.	 For 'Scale factor or first reference length,' click 

the other end of your reference length in your 
image.

5.	 For 'Second reference point,' you can either 
click again to set a distance manually, or type in 
the actual dimension of your reference length 
and press enter. Your image will be accurately 
scaled. You can now build a model on top of it.

Since it is advantageous to work at full scale in 
Rhino, use the actual or real world dimension to 
scale your drawing, not the dimension of the draw-
ing or model. For example, if you draw a 1/16”=1'-0" 
scale drawing of a square that is 16’x16’ in reality, 
you would use 16’ as your known distance, not the 
1” length of the square’s side on your paper. 

Once confident in the scale of the base image, you 
may next begin “roughing out” your drawing, first 
with construction lines as guides.  Save your im-
ported image onto its own layer, giving you the abil-
ity to lock it in place or turn it on or off as needed 
while drafting. 
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Analog Drawing to AutoCAD

Open Reference Files in AutoCAD You can bring 
.jpeg, .png, .pdf, and other files into your AutoCAD 
drawing. To do so:
1.	 Type the Attach command and press enter.
2.	 A 'Select reference file' dialog box will appear. 

Choose your file to open and click 'Open.'
3.	 A 'Attach image' dialog box will appear. 'Scale' 

and 'Insertion point' should both be set to 'Spec-
ify on screen by default. Click 'OK.'

4.	 Click once in your model space to choose where 
to place your image, and again to determine its 
size, which can be adjusted later.

Scaling
You can use the scale command to accurately size 
your image based on a particular line, shape, or 
other object length in the image:
1.	 Type the scale command and press enter.
2.	 Select your image to scale and press enter.
3.	 To 'Specify base point,' click one end of your 

reference length.
4.	 The command prompt will ask you to 'Specify 

scale factor.' Instead, click 'Reference.'
5.	 Click the start and end points of your reference 

length in your image and press enter.
6.	 Type in the actual dimension of your reference 

length and press enter. Your image will be accu-
rately scaled. You can now draft on top of it.

AutoCAD to Rhinoceros
This workflow might be helpful if you have drawn a 
plan in AutoCAD and now want to test how it works 
in 3D, or make renderings for a project.

.dwg files
AutoCAD is a powerful tool for drafting and devel-
oping drawings. Rhino is a powerful tool for 3D 

modeling. When used together, you can take models 

developed in Rhino and turn them into architectur-
al drawings in AutoCAD. Conversely, you can also 
take drawings from AutoCAD and turn them into 
3D models in Rhino.

This process is quite straightforward, given that 
both programs can read and generate .dwg files, 
which contain vector graphics — your linework. 

Attach image.

Select reference files
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Vector graphics are mathematically defined, mean-
ing each point, line, and shape can be infinitely 
scaled and not lose quality or resolution.

Opening .dwg files in Rhino
The default AutoCAD file type is .dwg, which can 
be opened in Rhino. You do not need to do anything 
specific when saving your AutoCAD file to open it in 
Rhino:
1.	 In Rhino, type the Insert command and press 

Enter.
2.	 An 'Insert' dialog box will appear. Click the 

folder icon on the upper right and select your 
.dwg file to open. You should not need to change 
anything in the 'Insert file options' box that 
appears, so just click 'OK.'

-	 Under 'Insert as,' check either 'As group' or 
'Individual objects.'

-	 Under 'Insertion point,' check 'Prompt.'
-	 Make sure that 'Scale' x, y, and z values are set 

to 1.0. If your AutoCAD and Rhino files are both 
set to inches, this will import your drawing at 
the correct scale.

-	 Click 'OK.'
3.	 Click on the screen wherever you would like to 

place your file.

You can now start using 2D to 3D commands such 
as Extrude to begin creating a 3D model from 
your linework. Plans can be extruded upward, and 
sections can be positioned vertically using Rotate3d 
before extruding.

Insert options.

Insert file options.
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Exporting: From 3D to 2D

Rhinoceros to AutoCAD
You will often develop a 3D model in Rhino and 
then need to produce drawings of your design. 
There are a few strategies you can use to expedite 
the process of getting your drawing started, before 
further developing and detailing it in AutoCAD.

Make2d
When working from a Rhino model, basic linework 
can be generated with the make2d command:
1.	 In Rhino, highlight your entire model (remem-

ber objects on locked layers will not be selected). 
2.	 Type the command make2d and press enter.
3.	 A dialog box — '2-D Drawing Options' — will 

appear with many options for your linework.
-	 Under 'view' there is a drop down menu where 

you can select which Rhino viewport you are 
making 2D.

-	 Checking 'Maintain source layers' means your 
linework will maintain the layer organization of 
your 3D model, which will carry over to Au-
toCAD and make it much easier to work with 
your drawing.

-	 Checking 'Hidden lines' will generate linework 
from objects hidden behind others in the view. 

Working in a front view to 
generate linework for an 
elevation.

Select every object needed 
for linework.

These lines will be assigned to separate 
hidden lines layers that can be easily 
turned off if not needed.

-	 Checking 'Scene silhouette' will generate 
linework on a separate layer that outlines 
the outermost edges of objects you are 
drawing. This can also be done manually 
and with more control after you have 2D 
linework using the curveboolean com-
mand.

-	 Checking 'Group output' will automatically 
group your linework, which can later be 
undone with the ungroup command.

-	 Click 'OK' to execute the command.
4.	 The 2D linework will appear in the top 

view near the origin point. It is import-
ant to move your linework as soon as you 
generate it, because all make2d linework 
will be deposited to the same location in 
your Rhino file. You will now have basic 
linework for your drawing, ready to take 
into AutoCAD.

Exporting
Once you have generated 2D linework from 
your model, make sure it is flat on the hor-
izontal drawing plane in Rhino. Errant 3D 
information may create issues with snaps in 
AutoCAD. To bring your linework into Auto-
CAD:
1.	 Select your linework.
2.	 Go to File>Export Selected... A dialog box 

will appear for you to name and choose 
where to save your file. Under 'Save as 
type:,' select 'AutoCAD Drawing File 
(*.dwg).' Click 'save.'

3.	 A 'DWG/DXF Export Options' dialog box 
will appear. When bringing drawings to 
AutoCAD, you will usually want to select 
'2007 Polylines' and click 'OK.' Your file will 
be saved.

Make2d options.

Linkedin Learning:
Make2D

Make2d linework in top 
view.
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4.	 There are two options to open this file in Auto-
CAD:

-	 Double click the file or start a new file in Auto-
CAD and type the command ‘open.’ From here, 
a window will open stating that this is a foreign 
.dwg file. Click ‘Continue opening DWG file.’ 
Your file will now be opened in AutoCAD.

-	 Alternatively, you can insert this new linework 
into an existing AutoCAD file, so that you can 
continue to work with any existing layers and 
lineweights. Type the insert command and 
press enter. An 'Insert' dialog box will appear. 
Click 'Browse...' and select your file to open. 

-	 Check 'Insertion point>Specify on-screen.' 
Under 'Scale,' make sure x, y, and z are all set 
to 1.0. If your Rhino and AutoCAD files are both 
set to inches, your drawing will automatically 
import at the correct scale. Click 'OK' and then 
click a location in your AutoCAD model space to 
place your new linework.

Notes
It is important to remember that the Make2d 
workflow from Rhino does not produce a finished 
drawing, but rather basic linework with which you 
can construct a drawing. This linework will usually 
require a bit of work to clean up inconsistencies 
before assigning it lineweight through your layers 
and then continuing to develop it as a 2D drawing.

DWG/DXF export options.

When modeling in Rhino, you often do not 
need to worry about modeling every single 
detail. Bringing basic model linework into 
AutoCAD is a great way to draw in details that 
would be overly complicated and time con-
suming to model in 3D. Also, the more com-
plicated a Rhino model is, the more clean up 
required once you have exported to AutoCAD.

AutoCAD insert options.
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Techniques: Axonometrics in Rhinoceros

Making an Axonometric (Plan Oblique) View
Rhino has built in isometric views that can be set by 
clicking on the name of any viewport and select-
ing Set View>Isometric. If you want to make a plan 
oblique axonometric, there are a few easy steps to 
follow:

1.	 Your model will be distorted within Rhino 
through this process. You should either save an-
other copy of your file or duplicate your models 
within Rhino using the Copy command before 
proceeding.

2.	 Select the model(s) you want an axon of and 
select them in the Top viewport.

3.	 To streamline the process, you can copy-paste 
one of the macro commands below directly into 
the Command Prompt in Rhino. Each com-
mand will make an axon rotated at the under-
lined number. You can also change this number 
to any angle you like for future use. For now, try 
the 30 or 60 lines below:

Select objects in the top 
viewport.

	 ! _Select _Pause _SetActiveViewport Top _
Rotate 0 45 _SetActiveViewport Right _Shear w0 
w0,0,1 -45 _SetActiveViewport Top _Zoom _All 
_Extents

	 ! _Select _Pause _SetActiveViewport Top _
Rotate 0 30 _SetActiveViewport Right _Shear w0 
w0,0,1 -45 _SetActiveViewport Top _Zoom _All 
_Extents

	 ! _Select _Pause _SetActiveViewport Top _
Rotate 0 60 _SetActiveViewport Right _Shear w0 
w0,0,1 -45 _SetActiveViewport Top _Zoom _All 
_Extents

4.	 When you paste the command into Rhino, your 
model will be rotated and sheared to create an 
axon view in the Top viewport. If your model 
leaves the viewport, it will still be selected, so 
you can use the Zoom command to zoom to 
selected objects and locate it. The model will be 
distorted in other viewports – this is why it is 
important to copy your model before starting 
this process.

Resulting plan oblique 
axonometric view.
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Making an Axonometric View Manually
Axonometric views can also be made manually in 
Rhino with a few manipulations to a model. Again, 
it is important to save a copy of your model before 
starting this process, as it will distort your model.

1.	 To make a 45 degree axon, start with top and 
right viewports visible.

2.	 Rotate your model in an increment of 45 de-
grees. Depending on the view you are trying to 
capture, other degrees of rotation can be used.

3.	 Working in your right viewport, highlight your 
model and type the command ‘shear.’

4.	 Click the bottom, left corner of your model as 
the base point.

5.	 Click above your model anywhere, keeping the 
shear line completely vertical.

6.	 Type ‘-45’ in the command bar and press 
‘enter.’

7.	 Your model in a 45 degree axonometric view 
will be visible in the top viewport.

Model is manually sheared 
to create an axon view.

Isometric View
Isometric views are built into Rhino. To set an iso-
metric view, click the viewport name at the top left 
of any viewport and select Set View>Isometric, then 
select one of the preset isometric views based on 
cardinal directions (NE, NW, SE, or SW).

The viewport with now be set to an isometric view 
with parallel projection. If you rotate the view, it 
will maintain parallel projection but will rotate 
around as with a perspective view.

Viewport>
Set View>
Isometric

Resulting isometric view.
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Adobe Creative Could

The Adobe Creative Cloud is a collection of software 
applications used to create graphics, edit photo-
graphs and videos, develop websites and apps, and 
more. Several Adobe programs are widely used in 
architecture school and in other design fields and 
professions. The Creative Cloud can be purchased 
at a discounted rate through Cavalier Comput-
ers through the QR code below. This section will 
introduce three commonly used Adobe programs: 
Photoshop, Illustrator, and InDesign.

Photoshop, Illustrator, and InDesign work hand in 
hand with the drawings, renderings, and other out-
puts explained in the Production Manual. Learning 
when to use each software begins by understanding 
the differences between Raster Images (Photoshop), 
Vector Graphics (Illustrator) and Publishing pro-
cesses(InDesign). Each of these softwares has excel-
lent translational capabilities with other drafting/
digital software and analog production methods. 
This makes it easy to integrate into current work-
flows and adapt to future ones as well. 

UVA Cavalier Computers:
Purchasing Adobe Creative 
Cloud

Key Terms

Photoshop

Illustrator

InDesign

raster

vector

workspace

panels

A powerful photo editing and raster graphics software 
developed by Adobe

a vector graphics software developed by Adobe, used to 
edit in vector files exported from Rhino, AutoCAD, and 
other softwares

a publication software developed by Adobe, used to create 
plot layouts, portfolios, books, and more

an image made from pixels, can be scaled down and not 
lose quality but loses quality and becomes pixelated when 
scaled up

a mathematically defined image format, meaning each 
point, line, and geometry can be infinitely scaled and not 
lose quality or resolution

the combination of panels, toolbars, and windows avail-
able on screen

small, docked windows that contain controls, options, 
and settings
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Photoshop

Why Photoshop?
Photoshop is a very powerful and versatile program 
for editing, manipulating, and creating images. 
Photoshop is one of many programs within Adobe 
Creative Cloud, a subscription service that can be 
obtained for a discounted rate through UVA Cav-
alier Computers. Once you have a Creative Cloud 
subscription, you will need to download and install 
Photoshop, which is available for both Windows and 
MacOS. Photoshop should function nearly identical-
ly on both systems, but there may be some variation 
in where tools are located. This document will show 
examples in the Windows version of Photoshop.

This Chapter Introduces:
	 Getting Started and Workspace Navigation
	 Photoshop Essentials Workspace Example
	 Layers
	 Tools
	 Image Adjustments
	 Transform
	 Saving
	 LinkedIn Learning supplemental material

Opening Images
Images can be easily opened in Photoshop by 
either dragging into the program window, or under 
File>Open…. 

Workspace Navigation
A Hand tool for panning and a Zoom tool can be 
found in the left toolbar, but it is faster to use a 
mouse and keystrokes below:

	 Scroll up/down: mouse wheel
	 Scroll left/right: ctrl+mouse wheel
	 Zoom: alt+mouse wheel
		  ctrl++ (zoom in)
		  ctrl+- (zoom out)

File settings
Image>Image Size… opens a dialog box where you 
can edit the width and height of your image in 
various units (pixels, inches, etc.) as well as change 
the image resolution. The small chain link icon 
maintains image proportions. These options can 
be helpful to check if you have an image that has 
an unexpectedly large file size. Since Photoshop is 
primarily a raster program, and images that you 
reduce in size and then enlarge again later will 
suffer from a loss in quality. It is a good idea to keep 
an unedited version of your images in case you need 
to edit them differently in the future.

Image size.
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Toolbar

Size & resolution Image Canvas

Open file tabs

Default Photoshop ‘Essentials’ Workspace.

Panel Dock

Layers
The default Photoshop workspace is called ‘Essentials’ 
and contains most or all of the tools you will most com-
monly use. If you are missing a certain tool or menu 
item in your workspace, it can likely be turned on via 
the Window dropdown menu at the top of the screen.
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Image>Canvas Size… will open a similar dialog 
box to edit the width and height of the Photoshop 
canvas. This will essentially change the bounds of 
the frame that your image exists within and will not 
affect the size of the original image.

Layers
Like many other design programs, Photoshop uses 
a layer system to control the various properties of 
groups of objects. The Layers menu is found in the 
tools to the right side of the screen. When opening 
a JPEG image, you will find a single layer in your 
file named “background.” Click the lock icon next 
to the layer name to unlock it and make it edit-
able – you will see the lock disappear and the layer 
name change to “Layer 0.” Also in the Layers menu 
are options to change the opacity, fill, and mode 
of the layer, and you can edit the layer name by 
double-clicking on its text. Double-clicking on the 
layer thumbnail will open the Layer Style dialog 
box, which contains a series of various style effects 
including stroke, glow, shadow, etc. To the left of 
the layer thumbnail is an eye icon that will toggle 
the visibility of the layer.

When working with a file that has multiple objects, 
it is good practice to organize and name layers 
accordingly. You can also create groups to further 
keep your file in order.

Canvas size.

Layers panel.

Tool Icons
Many of the toolbar icons along the left side of the 
screen will show small thumbnail videos of their 
various effects when you mouse over the icon. This 
also produces a “Learn how” button that will open 
a simple set of instructions explaining the use of 
the tool, which can be very helpful. A small arrow 
symbol to the lower right of a tool icon means other 
related options are available and can be accessed 
by right-clicking or left-clicking and holding on the 
icon.

Selecting Tools
When making targeted adjustments to your image 
in Photoshop, it is often helpful to select specific 
regions of your image to manipulate.

Marquee (M)
The Marquee selection tools allow the quick selec-
tion of rectangular or elliptical regions within your 
image.

Lasso (L)
The Lasso tools allow for the more manual selection 
of regions in the image. The Lasso tool is complete-
ly freehand with your cursor, the Polygonal Lasso 
tool allows the creation of a series of polygon cor-
ners with a series of mouse clicks, and the Magnetic 
Lasso tool will automatically snap to nearby edges 
within the image.

Tool Icons

Move (V)

Marquee (M)

Lasso (L)

Object Selection (W)

Crop (C)

Frame (K)

Eyedropper (I)

Spot Healing Brush (J)

Brush (B)

Clone Stamp (S)

History Brush (Y)

Eraser (E)

Paint Bucket (G)

Smudge

Dodge (O)

Pen (P)

Type (T)

Path Selection (A)

Rectangle (U)

Hand/Pan (H)

Zoom (Z)

Edit Toolbar

Quick Mask Mode

Change Screen Mode

Foreground & 
Background Color

Marquee tools.

Lasso tools.
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Object Selection/ Quick Selection/ Magic Wand (W)
The Object Selection tool recognizes people, skies, 
water, and other items in an image. When hovering 
the mouse above the image, the object will be high-
lighted in pink.  The Quick Selection tool recognizes 
edges along an image. The Magic Wand tool allows 
for the targeted selection of specific colors or tones 
in the image. The tolerance or range of the selection 
can be adjusted, as well as if the selection is a single 
contiguous region, or all applicable regions across 
the image.

When using each of these tools, the degree of 
‘feather’ (measured in pixels) can be adjusted in the 
top toolbar. This will adjust the crispness or blur of 
the edge of your selection. Selected regions will be 
visible with a dashed line edge. Right-clicking on a 
selected region while a selection tool is active will 
pull up a drop down menu allowing you to move or 
copy the selection to a new Photoshop layer (‘Layer 
Via Copy’ or ‘Layer Via Cut’). Selections can be 
quickly deselected with ctrl+D.

Crop (C)
As the name implies, the Crop tool allows you to 
crop your image, which will also change the size of 
the canvas. Clicking and dragging the corners and 
edges of the crop box will resize it. Holding shift 
while dragging will lock the box proportions. You 
can also input a specific ratio or dimension at the 
top of the screen.

Another tool within the Crop icon is the Perspective 
Crop tool, which will allow you to crop and correct 
perspective in one step. Correcting perspective can 
also be done with the transform tools discussed 
below.

Quick Selection and Magic 
Wand tools.

Object Selection tool iden-
tifies woman.

Quick Selection tool 
recognizes the edges of the 
opening. 

Magic Wand recognizes 
the blue background of the 
base image

Touchup Tools
Dodge/Burn/Sponge
The Dodge, Burn, and Sponge tools are brush tools 
that can be used to make targeted adjustments to 
specific regions of your image.

Dodge will lighten the image, and you can use the 
tool menu adjustments along the top of the screen 
to change the size of the brush, the range of tones 
to effect (highlights, mid-tones, shadows), and the 
exposure level. For most fine-tuning adjustments, 
a very low exposure level (5% or lower) is recom-
mended.
Burn works the same way as Dodge but will darken 
instead of lighten.
Sponge works in a similar manner to Dodge and 
Burn but can be used to either increase saturation 
or to desaturate specific regions of the image.

Spot Healing Brush
The Spot Healing Brush can be used to paint 
over undesirable smudges or marks in the image 
and will remove them by automatically detect-
ing neighboring parts of the image to predict the 
colors, tones, and textures that should fill in where 
the marks are removed. Choose a brush size that 
closely matches the size of the marks to remove, but 
make sure that you paint over them entirely. 

Healing Brush
The Healing Brush works in a similar manner to 
the Spot Healing Brush, but instead of automati-
cally predicting how to fill the region in, it allows 
you to control and select how this is done. Once 
you have the Healing Brush tool selected, use 
alt+left-click to select a point in you image. This 
will be the starting point in your image that will be 
used to paint over other parts of the image. This is 
particularly useful for correcting distortions along 
straight edges in your photos, and other fine details.

Richer colors and contrast 
created with Dodge, Burn 
and Sponge tools

Dodge, Burn and Sponge 
tools.

Healing Brush tools.
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Clone Stamp
Clone Stamp works in a nearly identical manner to 
the Healing Brush, but also allows you to adjust the 
opacity of the corrections you are making.

Image Adjustments
If editing a single image or a layer within a Photo-
shop file, you can make significant ___ changes 
using the multiple Adjustments features. They can 
be found on the Top Menu Bar, under Image. 

Brightness/Contrast
Image>Adjustments>Brightness/Contrast will 
bring up a dialog box with two sliders to adjust the 
brightness and contrast in your image. The ‘Pre-
view’ check box will toggle the display of your image 
between the original and adjusted versions. The 
‘Auto’ button will automatically adjust both sliders 
based on the tones and brightness of the image. You 
can try this as a starting point, but typically you will 
want to make these adjustments manually to more 
carefully control the final image.

Curves (ctrl + M)
Image>Adjustments>Curves… Here you can edit 
both the brightness and contrast of the image in a 
very controlled way. This is done by manipulating 
the curved line over the visible graph. Additional 
control points can be created to adjust the curve 
by clicking on the curve. Each end of the curve will 
control the lighter and darker tones in the image. 
If you want to increase the contrast in your image, 
pulling the left side of the curve down and the right 
side up will make the darks darker and the lights 
lighter. If you want to make the image brighter or 
darker overall, you can adjust the middle parts of 
the curve up or down, respectively.

Clone Stamp tools.

Levels (ctrl + L)
Image>Adjustments>Levels… Controls the range 
and distribution of input and output levels. The 
input levels graph has a slider bar below that allows 
for several adjustments. Manipulating the left end 
of the slider will make the dark parts of the image 
darker, while the right end of the slider will make 
the light parts of the image lighter. Shifting the 
center of the slider to the right or left will adjust the 
brightness of the middle tones in the image. Simi-
larly, adjusting the output levels slider will change 
the brightness of the lighter and darker tones in the 
image.

Curves dialog box.

Levels dialog box.
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Experiment with both Curves and Levels to de-
termine what method you prefer for editing your 
images. In general, Curves is helpful for fine tuning 
middle tones and adjusting contrast in a very con-
trolled way, while Levels is helpful for adjusting the 
brightest and darkest parts of the image, as well as 
overall brightness.

Color Balance (ctrl + B)
Image>Adjustments>Color Balance… Adjusts the 
color tones in an image. Adjusting the three sliders 
will shift the various color tones (cyan-red, ma-
genta-green, and yellow-blue). The top and bottom 
sliders in particular will be helpful in correcting 
warmer or cooler tones in your image that may be a 
result of the type of lighting or bulbs you are using 
in your model photography. These adjustments are 
made specifically to the shadows, mid-tones, or 
highlights in the image, and these modes can be se-
lected using the three buttons under ‘Tone Balance.’ 
Often you will want to try adjusting the sliders in 
each of these three modes to achieve the overall 
corrections you are looking for

Vibrance
Image>Adjustments>Vibrance… will bring up the 
Vibrance dialog box. This allows for another degree 
of control over the vibrancy and saturation across 

Color Balance dialog box.

either the whole image or the currently selected 
region. This is also helpful to easily correct for 
overly warm or cool tones in images.

Hue/Saturation (ctrl + U)
Image>Adjustments>Hue/Saturation… (or ctrl+U) 
will bring up the Hue/Saturation dialog box. This 
can be used to adjust the degree of saturation in the 
image and the overall color hue. More targeted color 
adjustments can be made to specific color tones by 
selecting one of these (reds, yellows, greens, etc.) 
from the ‘master’ drop down list.

Hue/Saturation dialog box.

Vibrance dialog box.



Production Manual  |  151150  |  University of Virginia School of Architecture

Rulers & Guides
When straightening or adjusting your image, it is 
often helpful to have some orthogonal guides over 
the image. This can be easily done using rulers and 
guides. View>Rulers (or ctrl+R) will turn on rulers 
along the top and left side edges of your work-
space. The units of the rulers can be changed by 
right-clicking on them. Left-clicking and dragging 
on either the top or left ruler will create either a 
horizontal or vertical guide over your image, re-
spectively. Once created, these guides can be moved 
by left-clicking and dragging them, and can be either 
locked or deleted through View>Lock Guides or 
View>Clear Guides.

Transform
Photoshop has a series of transform tools that allow 
you to easily scale, rotate, stretch, and otherwise 
distort your image. These can be found under 
Edit>Transform.

Free Transform can also be activated with ctrl+T 
and can be used to resize and rotate your image. 
Holding shift while performing these operations 
will toggle between various snaps and settings, such 
as maintaining the original image proportions and 
snapping to orthogonal angles.

Other transform tools allow you to distort the image 
in specific ways, which can be helpful to correct 
and straighten the perspective in an image. The 
perspective and skew transformations are helpful 
in this regard, and the warp transformation can 
help adjust for arcing of straight edges due to lens 
distortion. It is easy to overly distort your image 
using these transformations, so use guides to help 
you target and align edges.

Saving
When saving your work in Photoshop, pay attention 
to the file type you are saving. Saving a Photoshop 
(.psd) file will save all of your layers and Photoshop 
settings so that you can continue editing your file 
where you left off. Saving a JPEG (.jpg) file will 
flatten all of your layers and leave you with just an 
image, meaning the ability to edit individual layers 
will be lost. Saving as a .jpg means the file size will 
be much smaller, and that the file can be opened 
and inserted into a variety of other programs, 
while a .psd file can only be opened in Photoshop or 
placed into InDesign.

It is recommended to save a .psd file to preserve 
editing capabilities while working on your image, 
and to save a high quality .jpg file once you are have 
finished editing the image.

Edit> Transform.
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LinkedIn Learning:
Adobe Photoshop

Panning and Zooming

Free Transform

Marquee and Lasso ToolsExploring Layer Basics

Blend Mode Basics

A Tour of the Interface

Healing, Patch & Clone 
Stamp

Using the Crop Tool

Saving and Exporting
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Illustrator

Why Illustrator?
Adobe Illustrator is a vector graphics software 
popular with graphic designers. It is not a drafting 
software, so should never be used for drafting or 
lineweights in place of AutoCAD. However, it can 
edit vector files from Rhino, AutoCAD and other 
graphic softwares.  

Getting Started
To get started with a drawing in Illustrator, open 
the application and click 'New File.' A window will 
appear that lets you select the size of the artboard 
you will be working with and its units. After choos-
ing your file settings, click 'Create.' These settings 
can be changed later if needed.

Importing
You can import a variety of file types into Illus-
trator. Linework from AutoCAD or Rhino can be 
imported as a .dwg or .pdf. You can export linework 
directly from Rhino as an Illustrator .ai file, which 
will preserve all of your Rhino layers. It is import-
ant to note that Illustrator is not a drafting tool. 
Any linework imported into Illustrator should be 

in a finished state. Illustrator is used for additive 
elements and advanced graphics, not as a precise 
drafting software.

Images can also be imported into Illustrator for 
additive graphics in nearly all file types. Nota-
bly, images being worked on in Photoshop can be 
imported directly as a .psd file. This creates a link 
between the image in Photoshop and Illustrator and 
changes in either program will be reflected in the 
other.

To import any type of file into Illustrator, use File>-
Place.

Panning and Zooming
Pan by holding the spacebar+click+drag. You can 
also hit 'H' on your keyboard and use the mouse to 
pan in the same way.

There are several different ways to zoom into your 
artboard. One is to hold ctrl++ to zoom in or ctrl+- 
to zoom out. Another way to zoom is by hitting 'Z' 
on your keyboard, then hold alt+scroll with your 
mouse wheel. Hitting ctrl+0 zooms to your full 
artboard in frame.

New Document window.
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Open file tabs

Art Board 1

Toolbar

Current tool options

Illustrator  ‘Essentials’ Workspace.

The default Illustrator workspace is called 'Essentials.' 
You will find more useful tools in 'Essentials Classic.' 
This can be found by clicking the workspace menu at 
the top right side of your screen. If you are missing a 
certain tool or menu item in your workspace, it can 
likely be turned on via the Window drop down menu at 
the top of the screen.

Art Board 2

Switch workspace

Panel options

Workspace Drop-Down
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Document Set Up
Document settings can be changed once you have 
started a drawing in Illustrator. The document 
setup button can be found in the right properties 
panel, as well as the top banner. 

To change the size and other settings of your art-
board, click 'Edit Artboards' in the document setup 
window, followed by 'Artboard Settings,' which will 
appear in the right properties panel. Here, you can 
also add, remove, and rearrange artboards.

Layers
Like other programs, Illustrator organizes objects 
with a layer system. The layers panel is found in 
the panel bar on the right side of the Artboard. 
The layer you are working in will be highlighted in 
blue. To add a new layer, click the plus button at the 
bottom of the panel. To delete a layer, click the layer 
you would like to delete, the click the trash can. To 
rename a layer, double-click the layer name.

Artboards panel.

Document Setup window.

Layers panel.

Select by layer.

Layers work in a stack, where the objects in the 
top layer appear on top of the objects in the layers 
below. To move a layer in the stack, click+drag a 
layer to the layer to the desired position in the stack.

Some other layer functions are found in this panel. 
The eye on the left edge shows what layers are visi-
ble. To turn a layer off, click the eye. To turn a layer 
back on, click the empty box in this column. Beside 
the eye is the lock. Layers that are locked cannot be 
edited or selected. To lock a layer, click the empty 
box in this column. To unlock a layer, click the lock.

Tools
Once you have started a new file and are in your 
preferred workspace, you can begin drawing or 
editing with the tools on the left side of your work-
space. You can learn what a tool does by hovering 
over it with your cursor and click 'Learn more' to 
learn how to use it if you are unsure. Also, any tool 
that has a small, gray triangle on its button has 
more similar tools associated with it. You can access 
that list of tools by right-clicking the tool button.

Selecting Tools
There are several different tools and ways to select 
objects in Illustrator, depending on your needs. 
The dark gray arrow is the Selection Tool (V). This 
tool allows you to select any object by clicking it or 
click+dragging. You can select multiple objects by 
holding shft while clicking individual objects or by 
click+dragging over multiple objects. You can also 
deselect an object with shft+click.

The lighter arrow below is the Direct Selection tool 
(A) . This tool allows you to select individual anchor 
points within an object, path segments, or individu-
al objects within a group.

In your layers panel, the colored square to the right 
Illustrator Toolbar

Selection (V)

Direct Selection (A)

Magic Wand (Y)

Lasso (Q)

Pen (P)

Curvature (Shift + ~)

Type (T)

Line (\)

Rectangle (M)
+ Other Shapes

Rotate (R)
+ Reflect (O)

Free Transform (E)

Shape Builder (Shift 
+ Live Paint (K)

Gradient (G)

Perspective Grid 

Eyedropper (I)

Artboard (Shift +O)

Hand/Pan (H)

Zoom (Z)

Switch Stroke & Fill
(Shift + X)

Stroke & Fill
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will show what layer your selection is on. You can 
select all objects in a layer by clicking this square. 

There is also a Select option in the top banner. By 
clicking on this, you can access different ways to 
quickly select similar objects (Select>Same).

When opening .pdf files, you may not be able to 
select individual lines or objects immediately. In 
this case, click on the drawing then right-click>Re-
lease Clipping Mask until individual objects can be 
selected.

Transform
There are many ways to transform an object. One 
is to select an object with the Direct Selection tool. 
Once selected, double-click the Direct Selection tool 
in the toolbar and a window with transform options 
will appear. In this window, you can move or rotate 
an object specified amounts. You can also right-click 
a selected object and a menu with more transform 
options, as well as other options for modification 
will appear.

To scale an object evenly, use the scale tool or type 
'S.' You can also scale an object by selecting it, then 
click+dragging from a control point. To evenly scale 
an object on all sides, hold shft+click+drag.

Live Paint
A common use for Illustrator is to add and edit 
hatches and fills in your drawings, since AutoCAD 
can struggle with complex hatch graphics.

Hatches can be created using the Live Paint Bucket 
tool found in the toolbar or by the keyboard shortcut 
'K.' Selected linework and objects can be converted 
into a live paint group that can then be populated 
with various hatches or fills.

Toolbar drop down menu.

Transform drop down 
options.

Color Fills and Hatches 
done with Live Paint.

Selection menu.

Panels
Panels appear by default on the right side of your 
workspace. They are used to modify and monitor 
what you are working on.

The Properties panel is very useful in editing your 
work and changes to reflect what you have selected. 
If nothing is selected, the Properties panel shows 
Artboard properties, which can easily be changed in 
this panel. When you select an object in your draw-
ing, the Properties panel changes to reflect what 
you have selected. There are basic transform and 
appearance tools that can be used from this panel 
for the selected object. While an object is selected, 
color properties can be changed through the color 
panels and linetypes can be customized through the 
Stroke panel. 

Here you will also find panels for Artboards, layers, 
exporting, gradients, and more.

If any panels disappear, they can be found in the 
Window tab on the top banner which lists other 
panels that can be added to your workspace. You 
can also reset your panels and tools by clicking the 
workspace button and selecting 'reset.'

Exporting
There are several ways to export your work out 
of Illustrator. You can use the workflow: File>Ex-
port>Export As... and an export window will appear 
where you can chose from various file types and 
an output destination for your file. You can also use 
File>Save As... and save your work under a specific 
file type.

If you are working with multiple Artboards and 
only want to export one, or export as individual 

Panels.

Stroke panel.

Swatches panel.
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Asset Export is a good option. To do this, highlight a 
drawing, then right-click>collect for export>a single 
asset. This takes you to the Asset Export panel. 
There are many functions of this panel, but for this 
specific use, you will click the 'Export for Screens' 
icon button, which is located beside the Export 
button. This will open an export window. Click 
'Artboards' at the top of the window. From here, you 
can name your Artboards and chose the type of file 
to export to, along with customizable file sizes.

LinkedIn Learning:
Adobe Illustrator

Walk throughExporting Files

Color Modes Stroke AttributesPanels

Selecting Objects Using Specific Transform Tools

Panning and Zooming

Using Layers

Illustrator Keyboard Shortcuts
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InDesign

Why InDesign?
InDesign is a versatile software used for designing 
layouts and organizing images and information on 
a page or pages. It excels in designing plot layouts, 
organizing presentations, and creating portfolios, 
books, and other documents that include a variety 
of text and visuals.

Getting Started
After opening InDesign, you will land on the home-
page, much like Illustrator and Photoshop, where 
you will find some preset layouts and page sizes. 
You can select from these options or can customize 
your own size, units, pages, margins, etc. Most of 
these options can be adjusted after the document is 
created. After setting these options, click 'Create.'

Document Navigation
Panning can be done in the same way as Illustrator 
and Photoshop: while the direct selection tool is 
in use, press space bar+click and drag to pan. The 
mouse wheel will scroll up and down through your 
pages, as with any website. You can jump to specif-
ic pages in your document by double-clicking on a 
page in the 'pages' panel.

New Document options.

Zooming is also done in a similar way to other 
Adobe programs. Use ctrl++ to zoom in and ctrl+- to 
zoom out.

Layers
The layers panel in InDesign is very similar to 
Illustrator. Layers are less necessary than in other 
Adobe programs, but can still be quite useful. The 
layers panel is found in the panels on the right side 
of the screen.

The layer you are working in will be highlighted in 
blue. To add a new layer, click the plus button at the 
bottom of the panel. To delete a layer, click the layer 
you would like to delete, then click the trash can. To 
rename a layer, double-click the layer name. Layers 
work in a stack, where the objects in the top layer 
appear on top of the objects in the layers below. To 
move a layer in the stack, click and drag a layer to 
the layer to the desired position in the stack. Some 
other layer functions are found in this panel. The 
eye on the left edge shows what layers are visible. 
To turn a layer off, click the eye. To turn a layer 
back on, click the empty box in this column. Beside 
the eye is the lock. Layers that are locked cannot be 
edited or selected. To lock a layer, click the empty 
box in this column. To unlock a layer, click the lock.
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Open file tabs

Toolbar

Current tool options

Zoom Preflight (document errors)

Linked Photoshop File

Ruler

Page edge

Linked Illustrator Artboards

Margin

Workspace selection

Panels

InDesign  ‘Classic Essentials’ Workspace.

The default InDesign workspace is called 'Essentials' 
and contains many of the tools you will most commonly 
use. It is recommended to change your workspace to 
'Essentials Classic' or 'Advanced' Like other Adobe pro-
grams, to find missing panels, click the Window drop 
down menu at the top of the screen to turn individual 
tools on and off.
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Pages panel.

Pages
When creating a document, you will begin with a 
window with page settings. Here, you can choose 
the units, dimensions, orientation, margins, 
number of pages, and other settings for your docu-
ment. There is also an option for facing pages with 
a check box. If the box is checked, your document 
will have spreads as in a book with a spine. If un-
checked, you will have an individual pages that do 
not face each other.

The Pages panel organizes all pages in order, with 
sets of two pages, called spreads. There are a few 
other important functions located in the Pages 
panel, including Parent pages at the top.

A-Parent can be accessed by double-clicking either 
of the pages in the row for spreads or the singular 
page if not working with facing pages. The pages in 
this row are called the ‘Parent Pages.’ This is where 
master grids can be made as well as footers, page 
numbers, or any other object or text that will be ap-
plied to all pages in a document. The setting made 
on the left page will be applied to all even pages. The 

settings made on the right page will be applied to all 
odd number pages. By default, the first page is con-
sidered a cover page and is not placed in a spread. 
If you are not working with facing pages, the parent 
page will be applied to all pages. 

In the Pages panel, pages can be added and deleted 
by clicking either the ‘Plus” button or ‘Trash Can’ 
button. You can move directly to a page by dou-
ble-clicking on it. You can also reorder pages within 
the document by highlighting them and clicking and 
dragging them to a new position.

Grids and Guides
Setting up guides before starting a layout helps 
create consistency and order across a layout. You 
can create guides both on parent pages and on indi-
vidual pages. Guides will be visible in InDesign and 
can be used to snap objects into alignment, but will 
not be exported or printed from your file.

To create a guide, click and drag from the Y ruler for 
a horizontal guide, or from the X ruler for a vertical 
guide. Guides can be further adjusted once creat-
ed. After creating a guide, select it with the direct 
selection tool. Once selected, its settings will appear 
in the upper toolbar, where you can type specific 
dimension for precise positioning. If you right-click 
on a selected guide, a drop down will appear with 
options to lock, hide, or delete guides.

Grids & Guides options.
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Tools
There are many tools in InDesign that work in the 
same way as tools in Illustrator. A few of the most 
commonly used tools include:

-	 Selection tool. When in use, you can select any 
object in your file by clicking on it, or select 
multiple objects by holding shft+clicking. To 
deselect an object you have selected, hold shft+-
click it a second time.

-	 The direct selection tool lets you select parts of 
objects to edit. For example, the direct selec-
tion tool allows you to select anchor points, 
text within a text frame or an image within an 
image frame, without selecting the frame.

-	 The type tool creates a text frame that can be 
typed within.

-	 The line tool creates lines, that can be edited for 
type, color, and lineweight.

-	 The rectangle frame tool is useful for setting up 
consistent layouts before placing images and 
text. It will create a blue box as a placeholder 
that you can later place text or an image into. 
Once selected, the top banner will give you 
options to type in a specific X and Y location 
for the frame, a specific size, scaling and angle 
options. To put text in a frame, select the type 
tool and click on the frame. To place an image 
in the frame, you will need to place a file.

Placing Files
InDesign works with placed files that are referenced 
from their stored locations. This means InDesign 
can preview and work with many files at once 
without slowing down. Placing files in an InDesign 
document is the same process as placing in an Illus-
trator document. After clicking File>Place (ctrl+D), 
select the image file you would like to place. You will 
then click to drop it on your page. You can move 
it by clicking it and dragging it. You can also place 

Toolbar.

Frame tool

Type tool

Selection tool

Direct selection 
tool

Line tool

images directly into a rectangle frame by selecting 
the pre-positioned frame before placing the image. 
Once an image is placed in a  document, there are 
several different way the image and the frame can 
be adjusted.

Linking Files
All files that are placed in InDesign are references 
linked to files stored elsewhere. By default, they will 
look pixelated in InDesign. It is important to keep 
files organized and in a specified location while 
working with them in InDesign. If files are moved, 
the link will be lost and InDesign will not be able to 
export the image at full quality.

The Links Panel holds all of the information on 
the links inside an InDesign document. If files are 
moved, it will show an error in the panel. Images 
can be relinked by double-clicking the error button 
and updating the new file location. Files can also be 
updated to new or different files in this way.

Editing Linked Files
InDesign also has the ability to link to working files 
from Photoshop and Illustrator. The files can be 
placed in their .psd or .ai formats and then quickly 
accessed through a feature called ‘Edit Original,’ 
which also works with .jpgs and other file types. By 
alt+double-clicking on an image, it will open the file 
in its original program. You can also right-click on a 
link in the Links panel and select 'Edit with.'These 
edits will be automatically reflected in InDesign 
once the original file is saved and closed.

Placing an image in a 
frame.
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Above: Image frame se-
lected; Left: Image selected 
inside frame.

Formatting Images
There are several different methods of formatting 
an image once it is placed into your file. If placed 
into a frame, you can right-click the Image>Fitting 
and choose an option to fit the image within the 
frame. Images placed without being placed into 
a frame will be inserted with an automatic frame 
around the extents. This will show in blue. This 
frame size can be adjusted manually by selecting 
the image frame and dragging its edges to their 
desired location. The image within the frame can 
also be adjusted manually by double-clicking inside 
the frame. This will highlight the frame in orange. 
Once highlighted, you can move the image position 
by clicking the frame and dragging it, or by using 
the arrow keys. You can resize it in the same way as 
the image frame. This is a quick way to effectively 
crop images within your layout, without needing to 
edit the original image.

When resizing an image frame (blue outline), hold-
ing shift will maintain image proportions. Holding 
alt will resize the image on all sides from its center 
point. Holding ctrl before click+dragging will resize 
the image and the frame simultaneously.

Fitting options.

Links panel.

Text
Text can be added with the Type tool and is a great 
way to annotate drawings with consistent sizes and 
styles. When the Type tool is in use, the proper-
ties panel will have many options for editing your 
text style: font, size, vertical and horizontal spac-
ing, color, and more. Additional font styles can be 
downloaded for free by opening the Creative Cloud 
application in a separate window and navigating to 
'Adobe fonts.'

Character and Paragraph Styles
Setting Character and Paragraph Styles allow you to 
easily set and change different text and font settings 
throughout an entire document with only a few 
clicks.

A character style is a set of formatting elements that 
can be applied to text. To create character styles:

1.	 In the top banner, click Type>Character Styles. 
2.	 Click the 'plus' button to create a new style.
3.	 Once you have created a new character style, 

double-click it in the character panel to open up 
its editing options. Here you can set basic and 
advanced options for your character style. 

4.	 To apply this style to more text in your docu-
ment, highlight the desired text, right-click on 
the style in the character style panel and select 
'Apply.'

Paragraph styles work in a similar way to character 
styles but contain formatting for both characters 
and paragraphs. To create a paragraph style:

1.	 In the top banner, click Type>Paragraph Styles. 
2.	 Click the 'plus button' to create a new style. 

Similarly to character styles, double-click your 
new paragraph to edit it. This will open 

Character Styles Panel.

Character styles options.

Paragraph style options.
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	 a window similar to the character styles, but 
with many more options. Paragraph styles are 
applied the same way as character styles.

Views
In the View drop down menu in the top banner, 
there are many different options for viewing your 
pages. ‘Screen Mode’ changes the way your work-
space appears behind your pages. ‘Display Per-
formance’ Changes the quality of images on your 
pages. Note that ‘High Quality Display’ can make 
InDesign run much slower once a lot of images are 
in your file. 

Toggling ‘Overprint Preview’ (ctrl+alt+shft+Y) will 
preview your placed files at full resolution. Pressing 
W will toggle on and off all blue frames and guides. 
Ctrl++ and ctrl+- can be used to zoom in and out at 
any time.

Saving
Similar to Photoshop, when you save a file in InDe-
sign, it creates and saves a working file, in this case 
a .indd file. This is important to maintain editing 
capabilities and other layout and guide options 
within your file. This file will need to be either 
exported to a PDF or other file type for printing or 
presentation, or packaged with links in order to 
be shared with collaborators or used on another 
computer.

Preflight
Before exporting a file, check the 'Preflight' button 
at the bottom of the screen. A green or red dot will 
indicate any errors in your file. Clicking on the 
arrow and selecting 'Preflight Panel' (ctrl+alt+sh-
ft+F) will open a dialog box that lists any errors 
in your document, including broken or missing 
links and overset text (text that extends beyond its 
frame).

Share drop down menu.

Exporting
Exporting can be done seamlessly through the 
'Share' button in the top banner. 'Quick Export as a 
PDF' will give you three preset options for file size.

More options can be found under File>Export..., 
which will open a dialog box that gives you custom 
control over how your document is exported. Here, 
you can choose to export specific pages, export the 
file as individual pages or as joined spreads change 
image resolution, and edit many other options.

The most common file to export from InDesign is a 
PDF, which can then be shared, viewed or presented 
on screen, or sent to a printer or plotter.

Packaging
Packaging is necessary if you plan to share or edit 
an InDesign file elsewhere, as it will bundle all 
linked files and information with the saved .indd 
file. You can package a file from the 'Share' button or 
File>Package... (ctrl+alt+shft+P).

Packaging a file creates a folder for your project, 
which includes a .indd file, a .idml file (editable by 
older versions of InDesign), a .pdf, all linked files, 

Export adobe PDF window.
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and all linked fonts. This is crucial for sharing a 
working file or for opening your file on another 
computer. Without the linked graphics and fonts, 
InDesign will not be able to display or export your 
file from a new location properly. It is also a great 
practice to package any file once you are done and 
store the folder in the cloud in case you lose files 
over time, so that you can edit your file or access 
linked files in the future. This can be beneficial 
while making a portfolio or other documents you 

Packaged file output.

Example InDesign portfo-
lio spread.

Creating and Applying 
Parent Page

LinkedIn Learning:
Adobe InDesign

Guides and Measurements

InDesign Keyboard 
Shortcuts

Options When Placing 
Images

Using the Links Panel

Adding Text Frames Paragraph Styles Exporting a PDF

Packaging and Preflight for 
Output
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Why Document your Work? 
It is critical to consistently document your work, 
capturing each phase of a design. As part of a 
working method, documentation of sketches and 
study models may help you move between 2D and 
3D, analog and digital as you iterate through design  
development.

Maintaining high quality images of your process 
and final work is also important for submitting 
documentation of your coursework and ensuring 
that you have a record for future use in your 
personal portfolio, website, etc. 

File Management 
The development of a good digital workflow begins 
with a clear, organized, and uncomplicated file 
structure. 

While working, save your files regularly and use the 
'Save As' function to create a new file when making 
significant changes so you have a back up available 
if needed. 

You will find that different offices and/or project 
teams will use different naming conventions 
to organize their work. Consistently following 
these conventions makes it possible to effectively 
coordinate and collaborate on shared projects. 

The following text outlines a strategy for organizing 
your digital files from the beginning of a design project. 
Be consistent in implementing the organizational 
system you choose to adopt for your personal use. 

Suggested File Naming and Folder Structure

File naming: 
Date (YYYYMMDD)_File name_Version#.file extension

EX. 20240702_test_collage_v1.psd

Folder Structure
01_Admin (subfolders if needed with names of types of    	
        docs) place for studio briefs, non-design specific     	
       documents like schedules, etc.

02_Reference (subfolders according to subject)
        ex. Research Materials, Precedent Images, Site 	
       Documentation, use meaningful folder names 	
        creates a “library" of reference materials for your      	
       project

03)_Working Files (subfolders for each design iteration	
        according to date/subject including an Archive 	
        folder for older iterations)
       2D and 3D process files

04_Documentation (subfolders according to date/               	
        subject) final 2d and 3d imagery, post-processed    	
        model photography, and presentation files      

At the end of each semester, archive your work to 
multiple long term storage locations. Using a Cloud 
based digital storage platform and an external hard-
drive are great options.



Production Manual  |  183182  |  University of Virginia School of Architecture

Site Documentation

Why Document a Site?
Site documentation is an important part of the 
design process. Collecting physical, spatial and ex-
periential information while visiting a site provides 
a critical understanding of the social, ecological, 
and material context for your design work.

Measuring a Site
To measure a site you will need a tape measure, 
pencil, and sketchbook to record dimensions. A 
camera is also helpful to record the spaces you are 
surveying. Be precise when measuring , and locate 
elements relative to one another. Take careful 
notes transcribing dimensions onto sketches or 
base drawings you may already have. Another 
way to measure is using parts of your body to take 
quick relative measurements to estimate the size 
of objects. Knowing the dimensions of your hands, 
forearms, feet, and stride length can be helpful for 
taking quick, approximate measurements while on 
site.

work by Isabel Hamilton, 
UVA SoA ARCH 1030

Sketching
Use orthographic, perspectival, and diagrammatic 
sketches to record spatial relationships and 
ephemeral qualities of your site. Annotate your 
sketches with observations as you draw. 

Photography
Photographs of your site serve as an important 
references throughout your design process. 

Photograph the extents of your site as well as its 
surrounding context. Take pictures both up close 
and from a distance. This is your chance to capture 
small details as well as changing qualities such as 
light, views, and the movement of human and non-
human users. 

Photos taken systematically can be pieced together 
to create collaged, panoramic views called joiners. 

Site Analysis
Visiting the site is your chance to capture 
information that cannot be researched or observed 
remotely. Make observations about the site 
including:
-	 Who or what is using the site?
-	 What activities are occurring? How are users 

moving through the site?
-	 Are people alone or in groups?
-	 What landscape elements define your site? 

planted forms? pavement? etc?
-	 What materials are present?
-	 At what speeds are people moving?
-	 Where is the site seen from, and how do you 

approach it? What can be seen from it?
-	 What sensory qualities are experienced? sight, 

sound, smell, touch, etc?

These questions will help you to develop and 
understand your goals for the site and become 
valuable information to drive the design process.
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Documenting Physical Models 
Physical models are often fragile and over time 
may become damaged. It's important to develop a 
regular practice of documenting physical models 
through high quality photography. Process images 
are helpful to explain your iterative process and 
design decision making in presentations and your 
portfolio, so all models, from rough study models 
through more resolved presentation models,  
should be photographed with the same level of care, 

Camera
Use the best camera available to you to photograph 
your models. A good quality DSLR camera is 
preferred. While these can be quite expensive 
to purchase, the school has cameras available to 
borrow. Many smartphone cameras are also capable 
of capturing high quality photographs of your 
models.

work by Philip Edmonston, 
UVA SoA ARCH 3010 

Regardless of the type of camera you are using, be 
aware of the default settings to prevent qualities 
such as brightness/contrast or saturation and color 
balance from being automatically over-corrected. 
You should not use any filters or other effects when 
taking your photos. Keeping these automatic edits 
to a minimum will allow you to more precisely 
control post-processing your images using more 
capable photo editing softwares.

Make sure that your camera is set to record images 
on the highest quality setting. Some DSLR cameras 
have special raw file formats (.CR2 on Canon 
cameras, for example) – these are unnecessary for 
most purposes, and the highest quality setting for 
.JPEG image files will be all you need. 

work by Marisa Yamamo-
to, UVA SoA ARCH 1030
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Backdrop
It is important to make sure you set up a neutral 
backdrop so the background of your images do 
not distract from the model you are documenting. 
While a white backdrop will highlight the shadows 
cast by your model in an interesting way, there 
may be other times when you have a specific need 
for a backdrop of a different color. This is usually 
reserved for a highly specific applications. 

There are a few easy strategies for setting up a clean 
white backdrop:

1.	 Single surface – Find a large sheet of thick 
white paper and prop it against a wall or other 
vertical surface so that the top of the paper 
is vertical and the bottom is horizontal. The 
paper should form a smooth radius in the 
middle to transition from horizontal to vertical. 
This is the preferred method and will ensure 
that there is not a visible seam or edge at this 

Single surface backdrop.

Curved back produces no visible edge.

Two surface backdrop.

Two pieces produce visible edge.

Example photo box with 
integrated backdrop and 
lighting.

transition point. The possibility of this method 
will depend on the size of the model you are 
photographing and the size paper available to 
you. Large scale plotter paper can work well, 
but make sure that there are no visible marks 
on the surface of your backdrop if there is 
anything printed on the underside of the paper 
you are using.

2.	 Two surface – Find two large sheets of thick 
white paper, chipboard, or other sheet mate-
rial. Place one horizontally on the ground and 
one vertically against a wall or other vertical 
surface. Make sure that the vertical sheet rests 
on top of the other, so that no other material is 
visible in the gap between the two. This method 
also works quite well but will leave a visible 
horizontal seam that may need to be removed 
digitally in Photoshop.

Using either method, position the model to avoid 
viewing edges of the backdrop.

The downside of using a white backdrop is that 
it may get dirty quickly, so take care to keep the 
backdrop surfaces as clean as possible and avoid 
sliding models across them or stepping on the 
backdrop if it is located on the floor.

Fabric is sometimes used as a backdrop but is often 
much more difficult to set up properly without 
showing drapes or folds, so is not recommended in 
most applications.

A variety of photo boxes are available on Amazon 
and other retailers that have some combination of 
integrated backdrops and lighting. These can be 
incredibly useful in producing professional photos, 
but the biggest limitation is usually size, since 
models will need to fit inside the photo box for 
documentation. The school has several photo boxes 
available for your use. 
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Lighting
Proper lighting is critical for good model photos. 
There are several considerations:

1.	 Color temperature – Avoid light that is overly 
cool (bluish) or warm (yellowish), instead 
aiming for neutral hued light. LED bulbs pro-
vide the highest degree of control over color 
temperature and are often sold with an option 
of color temperature options. Photographing 
with natural daylight is also an option and will 
usually be of a more neutral color temperature 
if not photographing too close to dawn or dusk.

2.	 Direction – Even, indirect lighting is important 
to evenly illuminate your model. Using a bright 
light source from farther away or using reflect-
ed light are both strategies to accomplish this. 
Make sure that there are no ‘hot spots’ on your 
model (specific areas that are much brighter 
than neighboring areas – this will often happen 
with more focused directional lamps, especially 
if they are very close to the model).

Too warm.* Too cool.*

Uneven color temperature.* Even neutral light.*

*Refer to digital version of 
the Production Manual for 
color images.

3.	 Shadows – It may be a good idea to intentional-
ly use a directional light to cast shadows within 
your model, and you can consider how shadows 
may highlight specific qualities or elements of 
your model. It's usually best to cast shadows 
with a single light source. You can experiment 
with multiple light sources at different angles, 
but this will create competing shadows cast in 
different directions, so is usually only done in 
specific applications.

4.	 Brightness – The brightness of your photos will 
be a result of both the lighting you use and the 
camera settings. Make sure that the photos you 
take are bright and well illuminated (white sur-
faces should look close to white, not medium 
or dark gray), but not so bright that parts of the 
image and details in the model become washed 
out – this is very difficult or impossible to cor-
rect when post-processing your images.

Too bright – washed out. Too dim.

Uneven lighting – hot spot. Even bright lighting.



Production Manual  |  191190  |  University of Virginia School of Architecture

Placement
For overall shots, your model should be placed on 
the backdrop so that it the backdrop fills the entire 
frame of the camera. Avoid placing the model too 
far back on the backdrop, as this can cause either a 
ripple in the curvature of the backdrop, or shadows 
that are cast against the vertical surface. If you are 
capturing your entire model in the frame, try to 
preserve some white space around the object so that 
you have more flexibility in cropping and editing 
the photo in the future. For detail shots, the model 
should fill the entire frame.

Manual Camera Settings (advanced)
If you have a dedicated digital camera, there are a 
few manual settings to know about if you want to 
have more control over the image:

1.	 ISO – ISO is a value related the sensor sensitiv-
ity to light (200, 400, 800, etc.). The higher the 
ISO value, the brighter the image will be, but 
very high ISO values will often produce more 
grainy or noisy images.

2.	 Aperture – Aperture or f/stop is a value de-
scribing the size of the camera aperture that 
lets light in (f/5.6, f/8, f/10, etc.). A larger value 
will let in more light and produce brighter 
images. The f/stop also affects depth of field in 
the image – smaller values will have a small-
er depth of field, meaning that objects in the 
foreground and background will appear more 
blurred, and higher values will have a larger 
depth of field, meaning that objects in the fore-
ground and background will be more in focus.

Avoid crooked photos. Use verticals as a guide to keep photos straight.

3.	 Exposure – Exposure or shutter speed is a 
duration in fractions of a second (1/200, 1/100, 
1/60, etc.) describing how long the aperture is 
left open to allow light to enter the camera. A 
smaller value will produce darker images, while 
a larger value will produce brighter images. If 
the exposure time is too long, images are more 
likely to be more blurry and less crisp, unless a 
very stable tripod or camera mount is used.

Angles and Quantity
Take multiple photographs thoroughly representing 
your model. This means taking many more photos 
than you think is necessary and then decide on the 
best images to spend time post-processing. 

If you are documenting a series of model iterations, 
it is good to photograph each from a very similar 
viewpoint so that they can be displayed consistently 
as a serial study. Except in special circumstances, 
photos should be straight so that the model is not 
angled or tilted sideways within the frame. Taking 
photos with the camera farther away but zoomed in 
will produce less severe foreshortening in the image 
(this should be done with a lens zoom as opposed to 
a digital zoom, which will produce a drop in image 
resolution). 

Try to experiment with different perspectives and 
viewpoints to show various parts and qualities of 
the model. Try to capture straighter elevational 
(side) views, as well as the plan (top) view. On 
models with interior spaces, try placing the camera 
close to capture views within these spaces. 

Close up – more perspectival distortion. Far away and zoomed in – less distortion.
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Documenting Physical Drawings
It is equally important to digitally document your 
drawing. This is critical for sharing and submitting 
your coursework as well as for use in your portfolio 
and elsewhere in the future.

Scanning Drawings
It is best to scan your analog drawings whenever 
possible. This requires a large flatbed or larger 
format rolling scanner. It is important to follow di-
rections provided for properly saving images from 
any scanner and to keep it's surfaces clean. 

You can usually control the size and the resolu-
tion of the scanned file (dpi), which ranges from 
below 100 up to 600 or 1200. 150dpi is usually good 
enough for printing, but it is a good idea to scan 
your drawings at 300dpi so that you have a higher 
resolution version if this is needed later – you can 
always downsize the image when post-processing, 

work by Emma Lohr, UVA 
SoA ARCH 1030

but you cannot add resolution that is not there. 
Resolutions of 600dpi and higher are usually not 
necessary unless you are planning on significantly 
enlarging all or part of your drawing.

You should generally save your scans as high-qual-
ity JPEGs in either color or black and white. Make 
sure that the automatic corrections on the scanner 
do not over-adjust the brightness and wash out 
linework. 

Photographing Drawings
If you do not have access to a large enough scanner, 
you can also produce high quality documentation by 
photographing your drawings in a similar manner 
to your model photography. You can do this with 
your drawing laying on a flat surface or pinned up 
on a wall. Most importantly, make sure that you 
have a good level of neutral color lighting spread 
evenly across the entire drawing surface. Avoid 
creating hot spots and shadows on the drawing. The 
same as with scanning, make sure that your draw-
ings are not washed out due to brightness/contrast 
adjustments happening through your camera set-
tings. Hold your camera is as straight and perpen-
dicular to the drawing as possible, and steady so the 
image comes out sharp and not blurry.

It is likely your photographic images will require 
post-process editing before they are used for pre-
sentations or portfolios. 
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Why Designers Present Their Work

The ability to present design work clearly and 
succinctly is a critical skill in architecture school 
and in the professional world. You will need to be 
able to present your work to peers, faculty and 
instructors, and invited critics in school, and 
to collaborators, consultants, and clients when 
working professionally.

Presentations are opportunities to convey your 
design process, focused on critical design decisions 
that impacted the outcome of your project.  Sharing 
your process helps support your argument, 
justifying why certain ideas in your work are 
important, and how these ideas and processes 
led to a particular design. You will often need to 
present to people unfamiliar with your project, so it 
is vital that you convey your ideas with clarity and 
precision.

A presentation is also an opportunity to begin a 
discussion and establish the criteria with which 
you would like a design to be evaluated. By focusing 
your presentation on specific aspects of a design, 
you can often suggest and shape the conversation 
that follows.

Presentation Formats in order of Formality

- Desk Crits- student + professor/SIA

- Pin-Ups- student + professor/SIA + peers

- Mid-Reviews- student + professor/SIA + peers + 
other faculty

- Final Reviews- student + professor/SIA + peers + 
other faculty +  invited/external critics

Whether formal or informal, presentations are 
not one sided but are, in fact, a discussion. Come 
prepared ask questions of your instructor, critics, 
and peers. Reviews are not aimed at identifying 
weaknesses in a project, but to consider a project 
holistically and provide constructive criticism and 
suggestions to help clarify the strengths and weak-
nesses of a project. It is also important to always be 
present and attentive for the reviews of your peers, 
both out of respect and because feedback given on 
any specific project likely carries lessons that you 
can apply to your own work in the future.
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Presentation Components + Preparation
Presentations generally consist of both oral expla-
nation and visual content (that may be shared dig-
itally or physically), unified by a project narrative. 
Good preparation is key to minimizing stress and 
getting the most out of a presentation. Remember 
that clarity and hierarchy of ideas is key throughout 
both oral and visual presentation content.

Step 1: Project Narrative
Think of your project as an essay. What is the 
thesis? What is the supporting detail? Design proj-
ects are often driven by a big idea or concept that 
helps you make decisions as a design is developed at 
different scales. Being able to articulate any driving 
ideas, concepts, or logics governing your design is 
the best way to make your project clear to others. 

Write a short script or bullet points of important 
points you need to cover when explaining your 
project.

Graduate students presenting 
their work in a final review
image by Tom Daly

Step 2: Visual Presentation
Make a list of drawings and models you need to 
support the main points of your project narrative. 
Your instructor may provide you a list to start from, 
but keep in mind that your project may require 
other types of drawings or models to best convey 
your ideas. 

Consider how viewers will perceive your visual pre-
sentation. Composing a visual narratives requires 
strategic use of hierarchy, color, or sequence to 
most clearly explain a project’s intention, process, 
and form.

Consider the following: 
-	 What should your audience look at first?
-	 What should be viewed for the most time?
-	 What composition of drawings makes the most 

sense to present your argument?
-	 What connects the separate elements in your 

visual representation?

Example pin up consisting 
of individual drawing 
pages composed in a grid.

52” x 11”
Site & Bulding Strategy Diagrams 
1/32” = 1-0”

52” x 23”
North-South Section 
1/16” = 1-0”

17” x 23”
Site Plan
1/64” = 1-0”

34” x 23”
Plan (Most Critical Floor) 
1/16” = 1-0”

Project
Text
(Template 
to be 
Provided)

17”x11”
Plan 
1/16” = 1-0”

17”x11”
Plan 
1/16” = 1-0”

17”x11”
Model
Photos

17”x11”
Model
Photos

17”x11”
Model
Photos

17”x11”
Painting 
Photo

17”x11”
Case Study 
Photo & Drawing

17”x11”
Painting
Diagrams

17”x11”
Case Study 
Diagrams

17”x11”
Painting
Models

17”x11”
Case Study 
Models

17”x11”
Painting
Models

17”x11”
Case Study 
Models

17”x11”
Painting
Models

17”x11”
Case Study 
Models



Production Manual  |  201200  |  University of Virginia School of Architecture

Digital vs. Print 
In digital presentations, ordering of information 
over multiple slides or pages is critical.

For presentations pinned up on a wall, the 
composition of drawings in relation to one another 
is critical. Use grids and guidelines to organize and 
align your drawings in an orderly way. Remember 
that it is best to keep layouts simple and clear, 
so that your design is critiqued rather than the 
formatting of your presentation.

When presenting large plots with multiple 
drawings or printing multi page layouts, visual 
hierarchy is particularly important. Make sure that 
drawings don't become overly crowded are printed 
at a scale that can be read by a panel of critics 
sitting in front of your work. 

Consider how your physical models will be 
arranged in relation to images on the wall. Smaller, 
lighter process models may also be pinned up on 
the wall along with drawings. While larger scale, 
detail models, and or models situated in a larger 
site context may sit on a podium or on the floor.

Step 3: Oral Presentation
Good verbal presentations are clear, concise, and 
meaningful. Practice ahead of time, especially if 
there is a time constraint for your presentation.

Begin your presentation with the big idea, concept, 
or argument, and then provide supporting 
information and examples of how the design 
supports this narrative. Good presentations do not 
over explain or dwell on less relevant details but 
should follow a similar hierarchy of detail presented 
in the visual representation of your work.

It is helpful to reference drawings and direct the 
audience's attention as you present. Always speak 
directly to a drawing. In other words, if you are 
describing some aspect of your project that is not 
illustrated somewhere in your visual presentation, 
you are missing a critical visual component of your 
work.

Know Your Audience
It is important to prepare presentation materials 
with your audience in mind. In more formal re-
views, you can assume that faculty and invited crit-
ics will be proficient in reading and understanding 
architectural drawings, just as design professionals 
will be in the workplace. As you prepare your pre-
sentation, keep your audience in mind as you decide 
how much specificity to provide on various aspects 
of your design.

Undergraduate student 
presenting their work in a 
final review
image by Tom Daly
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abstraction

AutoCAD

axonometric 
projection

closed (geometry)

command

composition

construction lines

cut plane

detail 

diagram

drafting

elevation

extrusion

figure

ground

a composition which is not a direct reference or 
representation

a 2D and 3D computer-aided design and drafting software 
developed by Autodesk

a drawing that shows a 3D view of an object in which the x, 
y, and z axis are all drawn to scale

often a solid, can be thought of as watertight, with no 
open edges or missing faces. A closed line is any closed 2D 
shape, where the start point is touching the end point

terms that are used to direct drawing and editing 
operations in command based sofitwares like AutoCAD 
and Rhino

the way elements in a drawing are organized and arranged 
on a page together or the way a series of drawings are 
organized and arranged together

also referred to as guidelines or regulating lines that 
extend across a page used as reference points for position 
and dimension between multiple elements or drawings

the supposed plane that cuts through an object to create a 
section or plan cut

in Rhino, the view of a model or drawing within a layout

a simplified representation of a literal, functional, 
experiential, or metaphorical facet of a composition, can be 
drawn and/or modeled, 2d and/or 3d

detailed drawing representing a real-life space or object, 
done using certain conventions, analog or digital

a drawing of the exterior of an object viewed from the side

a 3D object made from a base plane or curve

an element which stands out, contrasting with the ground

the background of a composition, contrasting with figures
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ground plane

hierarchy

hybridity

llustrator

implied space

InDesign

isocurve

iteration

layer

layout 

linear

line type

lineweight

medium

a representation of  the surface on which the object is 
placed on top or embedded 

the condition of superiority or priority of one element over 
another

the condition of being two things at once 

a vector graphics software developed by Adobe, used to 
edit in vector files exported from Rhino, AutoCAD, and 
other softwares

space which is not totally defined, making its bounds and 
character open to multiple interpretations

A publication software developed by Adobe, used to create 
plot layouts, portfolios, books, and more

line expressing the subdivisions of a surface

procedure in which repetition of a sequence of operations 
yields results successively closer to a desired result

a system of organizing objects and lineweight in digital 
software

in Rhino, where views of a model or drawing are placed at 
different scales to simulate a printed document(s)

characterized by an emphasis on line and line-like quali-
ties

the style of line in a drawing (continuous, dashed, etc.), 
different line types represent different information

describes the thickness and darkness of a line, ‘heavier’ 
lineweights are thicker/darker and convey informa-
tion closer to the cutting plane, ‘lighter’ lineweights are 
thinner/lighter and convey information further from the 
cutting plane

1. any raw material or mode of expression used in an 
artistic or creative activity 2. an intermediate agency, in-
strument,or channel; a means; esp. a means or channel of 
communication or expression

model 

model space

negative space

open (geometry)

organizational logic

orientation

orthographic 
projection

overlay

panels

paper space

parti

Photoshop

plan 

a three-dimensional representation, esp. on a small scale, 
of a person or thing or of a projected or existing structure; 
esp. one showing the component parts in accurate propor-
tion and relative disposition

infinite workspace in digital drafting and modeling soft-
ware

compositional strategy, space on the page which is not 
occupied, guiding viewers’ focus.

a solid object is open if it has missing faces, a curve is open 
if its end points do not connect

compositional strategy, rules which guide or govern a form 
making and/or graphic design layouts 

the implied direction of elements in a composition or form

a method for drawing of a three-dimensional object ac-
curately on a two-dimensional surface, a parallel projection in 
which all the projection lines are orthogonal to the projec-
tion plane and all dimensions are accurately represented 
to a scale without foreshortening, typically referring to 
primary drawing views of plan, section, and elevation

layering of multiple drawings, amplifying certain charac-
teristics of the drawn space or object 

small, docked windows that contain controls, options and 
settings

in AutoCAD, where the scaled version of a drawing is 
placed to simulate the actual piece of paper it will be 
printed on.

a simplified representation of a design objective, which 
abstractly shows the general goals of a project and guides 
decision making in the design process 

a powerful photo editing and raster graphics software 
developed by Adobe

a drawing looking down on an object from above, can be a  
top view or a cut plan with a horizontal cutting plane
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planar

plot

poche

polysurface

raster

Rhino

scale

section

solid

spatial boundaries

stereotomic

surface

tectonic

template

relating to or in the form of a plane or surface

refers to both a large scale print and a command for 
exporting and printing drawings

shaded or hatched area on a drawing showing where 
elements have been cut through

two or more surfaces joined together, often to create a solid

an image made from pixels, can be scaled down and not 
lose quality but when scaled up lose quality/become 
pixelated

a 2D and 3D computer-aided design software developed by 
Robert McNeel & Associates

a way of representing large objects in a smaller size that is 
still measurable and accurate

drawing of a vertical cut through an object viewed 
horizontally

a surface or polysurface that encloses a volume

made up of explicit or implicit “edges”, space is defined 
most importantly by the character of its bounds and 
contents

strategy of design using massive or solid elements or 
systems of elements, can follow an additive or subtractive 
logic

a continuous extent having only two dimensions (length 
and breadth, without thickness), whether plane or 
curved, finite or infinite; an entity such as constitutes 
the boundary of a solid object or separates two adjacent 
portions of space

strategy of designing through the connection of multiple 
elements or systems of elements, often following an 
additive logic using planar elements

a file with preset settings, styles and layouts

property of measurement in a drawing or model, typically 
referring to digital workspaces 

a mathematically defined image format, where each line, 
shape, and color can be infinitely scaled and not lose 
quality

1. a window that displays a drawing in AutoCAD 2. 
windows that show different views of  a workspace in 
Rhino

the interface made up of panels, bars and windows in an 
arrangement to work in any digital drafting or modeling 
software program

units

vector

viewport

workspace
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UVA School of Architecture Resources
https://www.arch.virginia.edu/resources

A-School Computer Requirements
https://www.arch.virginia.edu/resources/comput-
er-requirements

A-School Network Setup
https://www.arch.virginia.edu/resources/set-
up-your-computer

A-School Classes Folders
https://www.arch.virginia.edu/resources/class-
es-folders

A-School Printing
https://www.arch.virginia.edu/resources/printing

A-School Virtual Workstations
https://www.arch.virginia.edu/resources/virtu-
al-workstations

The Virtual Workstation is a tool provided by A 
School that gives students access to a high perfor-
mance graphic computing through their own com-
puters. The virtual workstation also has access to 
various softwares. It can also be useful to students 
working on Macs that need access to a Windows 
interface.

Cavalier Computers
https://www.cavaliercomputers.com/

UVA Software Gateway
https://virginia.service-now.com/its?id=software_
gateway
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